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kenmerken van uw nieuwe MP3-speler
Mooi. Intelligent. Betrouwbaar. En vooral leuk! Dat is uw nieuwe MP3-speler, 
en nog veel meer. Dankzij de compacte vormgeving neemt deze MP3-
speler slechts zeer weinig ruimte in uw zak in en de geavanceerde 
technologie zorgt voor een rijk geluid en scherpe, levendige 
afbeeldingen. U zult heel veel plezier beleven aan uw nieuwe MP3-speler, of 
u nu aan het sporten bent, uw favoriete nummers downloadt, video’s bekijkt 
of gewoon naar de radio luistert.
Nadat u hem eenmaal het gebruikt, vraagt u zich af hoe u ooit zonder hebt 
gekund.

MEER MULTI IN MULTIMEDIA
We noemen het een MP3-speler, maar het 
is veel meer dan dat. U kunt afbeeldingen, 
tekst en video’s bekijken en naar FM-radio 
luisteren.
De ingebouwde draadloze Bluetooth-
technologie verandert uw MP3-speler in uw 
eigen persoonlijke netwerk.

AANRAAKBEDIENING
Door licht op het aanraakvlak te tikken kunt 
u door de menu's bladeren.

WAAR VORM EN FUNCTIONALITEIT 
HAND IN HAND GAAN
Jazeker, hij is gestroomlijnd en mooi. Maar 
hij ligt ook lekker in de hand en is eenvoudig 
te bedienen.

LANGERE AFSPEELDUUR EN KORTERE 
DOWNLOADTIJD
Met een volledig geladen batterij kan 
maximaal 30 uur muziek en 4 uur video 
worden afgespeeld.
Het downloaden gaat sneller. Dankzij de 
compatibiliteit met USB 2.0 is de speler veel 
sneller dan modellen met USB 1.1.

WONDER VAN GELUIDSKWALITEIT
Uw nieuwe MP3-speler is uitgerust met 
DNSe™ (Digital Natural Sound-engine), 
de unieke geluidstechnologie van Samsung 
voor een rijker, dieper geluid en een 
ongelofelijke luisterbeleving.



veiligheidsinformatie
Betekenis van de pictogrammen en aanduidingen in deze gebruiksaanwijzing:

WAARSCHUWING

Risico van lichamelijk letsel met mogelijk fatale 
gevolgen.

LET OP
Risico van lichamelijk letsel of materiële schade.

LET OP

U kunt het risico op brand, ontploffi ng, elektrische schokken of 
lichamelijk letsel tijdens het gebruik van uw MP3-speler verminderen 
door de genoemde belangrijke voorzorgsmaatregelen in acht te nemen.

OPMERKING

Tips of verwijzingen naar informatie die u kunnen helpen 
bij het bedienen van de speler.

NIET proberen.

NIET demonteren.

NIET aanraken.

Volg de aanwijzingen nauwgezet op.

Haal de stekker uit het stopcontact.

Bel het servicecentrum voor assistentie.

Deze waarschuwingstekens dienen om persoonlijk letsel, van uzelf en van 
anderen, te voorkomen. Voer de aanwijzingen nauwgezet op.
Bewaar de gebruiksaanwijzing nadat u dit gedeelte hebt doorgelezen op een 
veilige plaats, zodat u deze informatie later nog eens kunt naslaan. 



veiligheidsinformatie
In deze gebruiksaanwijzing wordt het juiste gebruik van uw nieuwe 
MP3-speler beschreven. Lees de gebruiksaanwijzing zorgvuldig door 
om te voorkomen dat u de speler beschadigt of uzelf verwondt.
Let met name op de volgende serieuze waarschuwingen:

BESCHERM UZELF
Demonteer, repareer of wijzig het product niet zelf.

Zorg dat het product niet nat wordt. Het product is niet waterbestendig. 
Als het product nat wordt, schakel het dan niet in. Anders zou u een 
elektrische schok kunnen krijgen. Neem in dat geval contact op met het 
dichtstbijzijnde Samsung Service Center.

Gebruik de oordopjes niet als u op een fi ets zit of een auto of motor 
bestuurt.
Dit kan een ernstig ongeluk veroorzaken. Het is bovendien in enkele landen bij wet 
verboden.
Gebruik van de oortelefoon tijdens het lopen en joggen op de openbare weg, met 
name tijdens het oversteken, kan leiden tot ernstige ongelukken.

Let er tijdens het sporten of wandelen omwille van de veiligheid op dat 
de kabel van de oortelefoon niet achter uw arm of een object in uw 
omgeving kan blijven haken.

Plaats het product niet in een vochtige, stoffi ge of vuile omgeving. Anders 
zou brand kunnen ontstaan of loopt u het risico op een elektrische schok.

LET OP

WAARSCHUWING

LET OP



BESCHERM UZELF
Het gebruik van oortelefoon of hoofdtelefoon gedurende langere tijd kan 
leiden tot ernstige gehoorbeschadiging.
Blootstelling voor langere tijd aan een geluidsniveau van meer dan 85 dB kan uw 
gehoor nadelig beïnvloeden. Hoe hoger het geluidsniveau, des te ernstiger de 
mogelijke gehoorschade. (Een normaal gesprek vindt plaats op een niveau van 50 
tot 60 dB. Het geluidsniveau op de weg is ongeveer 80 dB.) U wordt uitdrukkelijk 
aanbevolen het volumeniveau op medium te zetten. (Medium is doorgaans minder 
dan 2/3 van het maximum.)
Als u een piep in uw oren ervaart, moet u het volume verlagen of het 
gebruik van oortelefoon of hoofdtelefoon staken.

UW MP3-SPELER BESCHERMEN
Bewaar of gebruik de speler niet bij temperaturen boven 35°C 
(bijvoorbeeld een sauna of in een geparkeerde auto).
Zorg dat u de speler nergens tegen stoot en laat de speler niet vallen.
Plaats geen zware voorwerpen op de speler.
Voorkom dat externe deeltjes of stof in het product komen.
Plaats het product niet in de buurt van magnetische objecten.
Zorg dat u een reservekopie van belangrijke gegevens maakt. Samsung is 
niet aansprakelijk voor verlies van gegevens.
Gebruik uitsluitend door Samsung geleverde of goedgekeurde 
accessoires.
Spuit geen water op het product. Maak het product niet schoon met 
chemicaliën als benzeen of thinner. Hierdoor kan er brand ontstaan, kunt 
u een elektrische schok krijgen en kan het oppervlak beschadigd raken.
Het niet opvolgen van deze instructies kan tot lichamelijk letsel leiden of 
schade aan de speler veroorzaken.

Als u deze gebruiksaanwijzing wilt afdrukken, adviseren we u dat u deze in 
kleur afdrukt en de optie “Aan pagina aanpassen” in de afdrukopties selecteert 
voor een betere weergave.

LET OP

OPMERKING

WARNING

LET OP
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basisinformatie
INHOUD VAN DE VERPAKKING
Bij uw nieuwe MP3-speler worden de volgende accessoires geleverd. Als een van 
deze items ontbreekt, moet u contact opnemen met de klantenservice van Samsung.

Speler Oortelefoon

USB-kabel Installatie-cd

Het ontwerp van de accessoires kan ter verbetering van het product zonder 
voorafgaande kennisgeving worden gewijzigd.
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UW MP3-SPELER

Toets Aan/uit en Vergrendelen
Schuiven en vasthouden in de 
tegenovergestelde richting van de pijl om het 
apparaat in of uit te schakelen.
Schuiven in de richting van de pijl om de 
functietoetsen te vergrendelen.

Scherm

Resetopening
Als er een storing in de speler 

optreedt, drukt u met een puntig 
voorwerp in de resetopening om het 

systeem opnieuw te initialiseren.
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UW MP3-SPELER (vervolg)
Deze toetsen zijn aanraaktoetsen.

Toets Menu
Hierop tikken om het menuscherm weer te geven.

Toets Volume omhoog
Hierop tikken om het volume te verhogen of om 

naar een bovenliggend item of menu te gaan.

Toets Vorige
Hierop tikken om naar het vorige scherm te gaan.
Iets langer indrukken om naar het scherm met het 

hoofdmenu te gaan.

Linkertoets Bestandsbrowser
Hierop tikken om naar het vorige nummer of menu 
te gaan of het huidige nummer vanaf het begin af 

te spelen.
Iets langer indrukken om snel langs de nummers 

te lopen.

Toets Afspelen/Onderbreken/Selecteren 
Hierop tikken om afspelen/onderbreken en functie 

te selecteren, naar het volgende scherm gaan.

Toets Volume omlaag
Hierop tikken om het volume te verlagen of om 

naar een onderliggend item of menu te gaan.

Rechtertoets bestandenbrowser
Hierop tikken om naar het volgende nummer of 

menu te gaan. Iets langer indrukken om snel langs 
de nummers te lopen.
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UW MP3-SPELER (vervolg)

Oortelefoon
Op het linkerdopje ziet u een 
“L” en op het rechterdopje 
een “R”. Fungeert tevens als 
antenne voor de FM-radio in de 
MP3-speler.

Oortelefoonaansluiting

Bevestiging nekkoord

USB-aansluiting

Microfoon
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SCHERMEN
Muziek

1
Bluetooth/
Vergrendelingsindicator

2 Indicator hoofdmenu

3 Batterijstatus

4
Indicator huidig nummer/totaal 
aantal nummers

5 Afspeelsnelheidsindicator

6 Huidige tijd

7 Totale afspeeltijd

8 Afspelen/pauze, zoeken

9 Indicator muziekmodus

10 Indicator afspeelmodus

11 Indicator DNSe-modus

12 Muziekafspeelscherm

13 Statusbalk afspelen

14 Huidige afspeeltijd

15 Titel

Songs

8

9

10

11

13

14

15

1

3

2

4

5

6

7

De schermafbeeldingen dienen slechts ter illustratie. Het scherm kan er in 
werkelijkheid anders uitzien.

12

OPMERKING
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SCHERMEN (vervolg)
Video

1
Bluetooth/
Vergrendelingsindicator 6 Indicator videomodus

2 Batterijstatus 7 Bestandsnaam

3 Huidige tijd 8 Statusbalk afspelen

4 Totale afspeeltijd 9 Huidige afspeeltijd

5 Afspelen/pauze, zoeken

Video Track 1

5

6

7

8

9

1

2

4

3
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SCHERMEN (vervolg)
Afbeelding

1
Bluetooth/
Vergrendelingsindicator

2 Batterijstatus

3
Indicator huidig bestand/totaal 
aantal bestanden

4 Huidige tijd

5 Afspeelstatus muziek

6 Indicator Afbeeldingsmodus

7 Indicator hoofdmenu

8 Bestandsnaam

FM-radio

1
Bluetooth/
Vergrendelingsindicator

2 Batterijstatus

3 Huidige tijd

4 Indicator radiomodus

5 Handmatig/voorinstellingen

6 Huidige frequentie (MHz)

Pictures

Picture Image1.jpg

5

6

7

8

1

2

3

4

MANUAL

4

5

6

2

3

1

[Voorbeeldscherm]
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WERKEN MET HET AANRAAKVLAK
Tik met uw vingertop op het aanraakscherm.

Gebruik geen andere voorwerpen dan uw vingers om op het scherm te tikken. 
Anders zou het aanraakscherm kunnen beschadigen.
Tik niet op het aanraakscherm met vuile vingers.
Tik niet op het aanraakscherm met handschoenen aan.
Het aanraakscherm werkt mogelijk niet goed als u bijvoorbeeld uw vingernagel of 
een balpen gebruikt.

OPMERKING
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DE BATTERIJ OPLADEN
Laad de speler op voordat u deze voor het eerst gebruikt en wanneer u deze 
lange tijd niet hebt gebruikt.
Het volledig opladen van de batterij van de MP3-speler duurt ongeveer 3 uur. 
De oplaadtijd kan echter variëren, afhankelijk van uw computeromgeving.

Voordat u begint! - Verwijder de oortelefoon voordat u de USB-kabel aansluit.

1. Sluit het andere (grotere) uiteinde van de USB-kabel aan op de USB-
aansluiting aan de onderkant van de speler.

2. Sluit de USB-kabel aan op de USB-poort ( ) van de computer. 

Schermweergave
Verbonden via USB
Bezig met opladen
Volledig opgeladen

2
1
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ONDERHOUD VAN DE BATTERIJ
De batterij gaat langer mee als u de volgende eenvoudige aanwijzingen voor 
het gebruik en de opslag ervan opvolgt.
• Opladen en bewaren bij een temperatuur tussen 5°C en 35°C.
• De batterij niet te lang opladen (niet langer 12 uur). 

Overmatig opladen of ontladen kan de levensduur van de batterij verkorten. 
• Aangezien een batterij een verbruiksartikel is, neemt de levensduur van de 

batterij na verloop van tijd geleidelijk af.
Als u de speler oplaadt door deze aan te sluiten op een draagbare computer, 
controleer dan eerst of de batterij van de draagbare computer zelf volledig is 
opgeladen of de draagbare computer is aangesloten op het lichtnet.

DE SPELER IN- EN UITSCHAKELEN
De speler inschakelen
Schuif en houd de schakelaar ingedrukt in 
de tegenovergestelde richting van de pijl. 

De speler wordt ingeschakeld.

De speler uitschakelen
Schuif en houd de schakelaar nogmaals
ingedrukt in de tegenovergestelde richting van de pijl. 

De speler wordt uitgeschakeld.

Het toestel wordt automatisch uitgeschakeld als gedurende een bepaalde tijd geen 
toetsen worden ingedrukt in de stopstand. De fabrieksinstelling voor <Auto Power 
Off> (Autom. uitschakelen) is 1 minuut, maar u kunt deze tijd zelf wijzigen. Zie 
pagina 28 voor meer informatie.

OPMERKING

OPMERKING
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MUZIEK AFSPELEN
Kopieer muziekbestanden naar uw nieuwe MP3-speler met Samsung Media 
Studio. Meer informatie over Media Studio vindt u op pagina 32.
1. Houd [ ] iets langer ingedrukt om naar het scherm met 

het hoofdmenu te gaan.
2. Tik op [ ] om <Music> (Muziek) te selecteren en tik 

vervolgens op [ ].
3. Gebruik de toetsen [ ] en [ ] om het gewenste 

muziekbestand te selecteren.
4. Tik op  [ ].

Het muziekbestand wordt afgespeeld.
Tik op [ ] om naar het vorige scherm te gaan.
Houd [ ] iets langer ingedrukt om naar het scherm met het hoofdmenu te gaan.

HET VOLUME REGELEN
Tik op  [ ].

Er wordt een volumesymbool weergegeven.
Het volumebereik is ingesteld van 0 tot 30.

Tik op [ ] om het volume te verhogen of op [ ] om het volume 
te verlagen.

OPMERKING

Music

Music
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DE TOETSEN VERGRENDELEN
Met de vergrendelfunctie kunt u alle andere toetsen op 
de MP3-speler vergrendelen, zodat uw muziek niet wordt 
onderbroken wanneer een van de toetsen, bijvoorbeeld 
tijdens het sporten, per ongeluk wordt ingedrukt.
1. Schuif de  schakelaar in de richting van de pijl.
2. Schuif de schakelaar in de 

tegenovergestelde richting van de pijl om de 
vergrendelfunctie uit te schakelen.

BESTANDEN ZOEKEN MET “File Browser”
(Bestandsbrowser)
U kunt eenvoudig bestanden zoeken met de functie 
<File Browser> (Bestandsbrowser).
1. Houd [ ] iets langer ingedrukt om naar het scherm met 

het hoofdmenu te gaan.
2. Tik op [ ] om <File Browser> (Bestandsbrowser) te 

selecteren en tik vervolgens op [ ].
De map <File Browser> (Bestandsbrowser) wordt weergegeven, 
met daarin “Music, Playlists, Video, Pictures, Datacasts, Texts en 
Recorded Files”.

3. Tik op [ ] om een gewenste map te selecteren.
4. Tik op [ ] om de lijst met bestanden in de geselecteerde map weer te geven.

Tik op [ ] om naar het vorige scherm te gaan.

5. Tik op [ ] om een gewenst bestand te selecteren.
6.  Tik op  [ ].

Het bestand wordt afgespeeld.

Music
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INSTELLINGEN EN VOORKEUREN WIJZIGEN
De instellingen en voorkeuren van de MP3-speler zijn in de fabriek ingesteld, maar u kunt 
deze voorgeprogrammeerde waarden zelf aan uw persoonlijke voorkeuren aanpassen.

 Tik op [ ] om naar het vorige scherm te gaan.
Houd [ ] iets langer ingedrukt om naar het scherm met het hoofdmenu te gaan.

Instellingen voor menustijl
U kunt het uiterlijk van het menu wijzigen en de achtergrondafbeelding 
van het hoofdmenu verwijderen.
1. Houd [ ] iets langer ingedrukt om naar het 

scherm met het hoofdmenu te gaan.
2. Tik op [ ] om <Settings> (Instellingen) te 

selecteren en tik vervolgens op [ ].
Het menu <Settings> (Instellingen) wordt weergegeven.

3. Tik op [ ] om <Menu Style> (Menustijl) te 
selecteren en tik vervolgens op [ ].

Het menu <Menu Style> (Menustijl) wordt weergegeven.
4. Gebruik de toetsen [ ] en [ ] om de functies 

in te stellen.
Tik op [ ] om naar het volgende item te gaan of het menu te selecteren.
 Tik op [ ] om in het huidige menu te bladeren.

Instellingsopties voor menustijl
Menu Design (Menuontwerp) : U kunt de stijl van het hoofdmenu wijzigen. 
Maak een keuze uit <Sammy>, <Pendant> (Hangertje) en <My Skin> (Mijn huid).
 Color Tone (Kleurtoon) : U kunt de kleur van de menu- of schermachtergrond 
wijzigen. Als u in <Menu Design> (Menuontwerp) de optie <Sammy> (Sammy) 
instelt, wordt de functie <Color Tone> (Kleurtoon) uitgeschakeld.
 Font (Lettertype) : U kunt het lettertype van de menutaal wijzigen. Kies één van de 
drie lettertypes. Voor sommige talen wordt <Font> (Lettertype) niet weergegeven 
in het menu.
 Reset My Skin (Mijn Skin opnieuw instellen) : Stelt de achtergrondafbeelding 
van het aanraakscherm in op de standaardafbeelding. Als u in <Menu Design> 
(Menuontwerp) de optie <Sammy> of <Hangertje> instelt, wordt de functie <Reset 
My Skin> (Mijn Skin opnieuw instellen) uitgeschakeld.

OPMERKING

Menu Style
Sound
Display
Language
Date & Time
System

Settings
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INSTELLINGEN EN VOORKEUREN WIJZIGEN (vervolg)
Geluidsinstellingen
U kunt de hoofd-EQ, de pieptoon en de volumegrens 
instellen.
1. Houd [ ] iets langer ingedrukt om naar het 

scherm met het hoofdmenu te gaan.
2. Tik op [ ] om <Settings> (Instellingen) te 

selecteren en tik vervolgens op [ ].
Het menu <Settings> (Instellingen) wordt weergegeven.

3. Tik op [ ] om <Sound> (Geluid) te selecteren 
en tik vervolgens op [ ].

Het menu <Sound> (Geluid) wordt weergegeven.

4. Gebruik de toetsen [ ] en [ ] om de functies in te stellen.

Opties voor geluidsinstellingen
Master EQ (Hoofd-EQ) : U kunt de geluidsinstellingen optimaliseren.
Tik op [ ] om de frequentie te selecteren die u wilt aanpassen. Tik op [ ]
om het niveau van de geselecteerde frequentie aan te passen en tik op [ ].
Beep Sound (Piepgeluid) : Het geluidssignaal voor de bediening van het 
aanraakscherm inschakelen of uitschakelen. U kunt kiezen tussen <Off> (Uit) 
en <On> (Aan). Tijdens het afspelen van muziek wordt het geluidssignaal 
uitgeschakeld als u dit op <On> (Aan) instelt.
Volume Limit (Volume grens): U kunt gehoorbeschadiging bij gebruik van de 
koptelefoon voorkomen door een volumegrens in te stellen. Als de volumegrens 
is ingeschakeld, is het maximumvolume 15. 
Als de volumegrens is uitgeschakeld, is het maximumvolume 30.
Als u <Off> (Uit) selecteert, wordt het volume teruggezet naar 15 om schade 
aan uw gehoor te voorkomen wanneer u de speler weer inschakelt.

Settings

Menu Style
Sound
Display
Language
Date & Time
System
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INSTELLINGEN EN VOORKEUREN WIJZIGEN (vervolg)
Weergave-instellingen
De uitschakeltijd en helderheid van uw scherm wijzigen.
1. Houd [ ] iets langer ingedrukt om naar het 

scherm met het hoofdmenu te gaan.
2. Tik op [ ] om <Settings> (Instellingen) te 

selecteren en tik vervolgens op [ ].
Het menu <Settings> (Instellingen) wordt weergegeven.

3. Tik op [ ] om <Display> (Weergave) te 
selecteren en tik vervolgens op [ ].

Het menu <Display> (Weergave) wordt weergegeven.

4. Gebruik de toetsen [ ] en [ ] om de functies in te stellen.

Opties voor weergave-instellingen
Display Off (Display Uit) : Als geen wachttijd is ingesteld, wordt het scherm 
automatisch uitgeschakeld. U kunt kiezen uit <15sec>, <30sec>, <1min>, 
<3min>, <5min> en <Always On> (Altijd aan). U kunt het scherm weer 
inschakelen door op een willekeurige toets te drukken. 
Brightness (Helderheid) : u kunt de helderheid van het scherm instellen.Kies 
een niveau van <0-10>, met 10 als meest helder.

Settings

Menu Style
Sound
Display
Language
Date & Time
System
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INSTELLINGEN EN VOORKEUREN WIJZIGEN (vervolg)
Taalinstellingen
De menu’s van de MP3-speler kunnen in diverse talen worden 
weergegeven. U kunt uw voorkeurstaal eenvoudig instellen.
1. Houd [ ] iets langer ingedrukt om naar het 

scherm met het hoofdmenu te gaan.
2. Tik op [ ] om <Settings> (Instellingen) te 

selecteren en tik vervolgens op [ ].
Het menu <Settings> (Instellingen) wordt weergegeven.

3. Tik op [ ] om <Language> (Taal) te selecteren 
en tik vervolgens op [ ].

Het menu <Language> (Taal) wordt weergegeven.
<English>, <한국어>, <Français>, <Deutsch>, 
<Italiano>, <日本語>, < >, < >, <Español>, < >,
<Magyar>, <Nederlands>, <Polski>, <Português>, <Svenska>, < >,
< eština>, < >, <Türkçe>, <Norsk>, <Dansk>, <Suomi>, 
<Español (Sudamérica)>, <Português (Brasil)>, <Indonesia>, <Ti ng Vi t>,
<Bulgarian>, <Român >, < >, <Slovenš ina>, <Slovenský>.

4. Tik op [ ] om de gewenste taal te selecteren en tik op [ ].

De ondersteunde talen kunnen worden gewijzigd of toegevoegd.

Settings

Menu Style
Sound
Display
Language
Date & Time
System

OPMERKING
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INSTELLINGEN EN VOORKEUREN WIJZIGEN (vervolg)
Datum en tijd instellen
U kunt de huidige datum en tijd instellen.
1. Houd [ ] iets langer ingedrukt om naar het 

scherm met het hoofdmenu te gaan.
2. Tik op [ ] om <Settings> (Instellingen) te 

selecteren en tik vervolgens op [ ].
Het menu <Settings> (Instellingen) wordt weergegeven.

3. Tik op [ ] om <Date & Time> (Datum en tijd) 
te selecteren en tik vervolgens op [ ].

Het menu <Date&Time> (Datum en tijd) wordt 
weergegeven.

4. Tik op [ ] om naar <Year, Month, Date, Hour, Min, AM/PM>
(Jaar, Maand, Datum, Uur, Minuut, AM/PM) te gaan en tik vervolgens 
op [ ] om elk item in te stellen.

5. Tik op  [ ].
6. Tik op [ ] om <Yes> (Ja) te selecteren en tik vervolgens op [ ].

De instelling van de tijd is voltooid.

Menu Style
Sound
Display
Language
Date & Time
System

Settings
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INSTELLINGEN EN VOORKEUREN WIJZIGEN (vervolg)
Systeeminstellingen
Kies de instellingen voor de sluimerfunctie en automatisch uitschakelen 
die bij u passen.
1. Houd [ ] iets langer ingedrukt om naar het 

scherm met het hoofdmenu te gaan.
2. Tik op [ ] om <Settings> (Instellingen) te 

selecteren en tik vervolgens op [ ].
Het menu <Settings> (Instellingen) wordt weergegeven.

3. Tik op [ ] om <System> (Systeem) te 
selecteren en tik vervolgens op [ ].

Het menu <System> (Systeem) wordt weergegeven.

4. Gebruik de toetsen [ ] en [ ] om de functies in te stellen.

Menu Style
Sound
Display
Language
Date & Time
System

Settings
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INSTELLINGEN EN VOORKEUREN WIJZIGEN (vervolg)
Opties voor systeeminstellingen

Sleep (Stand-by) : Het apparaat wordt na de opgegeven tijd automatisch 
uitgeschakeld. U kunt kiezen uit <Off> (Uit), <15 min >, <30 min>, <60 min>, 
<90 min> en <120 min>.
Start Mode (Startmodus) : U kunt instellen dat het startscherm wordt 
weergegeven als u de speler inschakelt. U kunt kiezen uit <Main Menu> 
(Hoofdmenu) en <Last State>(Vorige status). Kies <Main Menu> (Hoofdmenu) 
om het systeem op te starten in het hoofdmenu of <Last State>(Vorige status) 
om op te starten in het laatst gebruikte menuscherm.
Auto Power Off (Autom. Uitschakelen) : De speler wordt automatisch 
uitgeschakeld als het afspelen is onderbroken en er gedurende de opgegeven 
tijd geen toetsen worden ingedrukt. U kunt kiezen uit <15sec>, <30sec>, 
<1min>, <3min>, <5min> of <Always On>(Altijd aan).
Default Set (Standaard instellen) : De standaardwaarden voor alle instellingen 
worden hersteld. U kunt kiezen uit <Yes> (Ja) en <No> (Nee). Met <Yes> (Ja) 
zet u alle instellingen terug naar de beginwaarden. Met <No> (Nee) annuleert u 
het herstellen van de standaardinstellingen.
Format (Formatteren) : Het interne geheugen formatteren. U kunt kiezen uit 
<Yes> (Ja) en <No> (Nee). Als u <Yes> (Ja) kiest, wordt het interne geheugen 
geformatteerd en worden alle bestanden op de speler gewist. Als u <No> (Nee) 
selecteert, wordt het interne geheugen niet geformatteerd. Controleer voordat u 
gaat formatteren.
About (Info) : De fi rmwareversie en geheugencapaciteit controleren. 
Als u <Yes> (Ja) kiest, wordt het interne geheugen geformatteerd en worden alle bestanden 
op de speler gewist.
Met <Firmware Version> (Firmware-versie) wordt de huidige versie van de fi rmware 
weergegeven.
<Used> (Gebruikt) geeft het gebruikte geheugen aan, <Available> (Besch.) geeft het 
resterende geheugen aan en <Total> (Totaal) staat voor de totale geheugencapaciteit.

Het ingebouwde geheugen
1GB=1.000.000.000 bytes: de werkelijke, geformatteerde capaciteit is 
mogelijk minder omdat een gedeelte van het geheugen wordt gebruikt door 
de interne fi rmware.

OPMERKING
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DE MP3-SPELER RESETTEN
Als uw MP3-speler niet start, geen muziek wil afspelen of niet wordt herkend 
door uw computer wanneer u deze aansluit, is het misschien nodig het systeem 
te resetten.

Druk met een puntig voorwerp, zoals een 
veiligheidsspeld, aan de onderzijde van het 
product de Resetopening in.

Het systeem wordt geïnitialiseerd.
Met de Reset-functie worden geen 
tijdgegevens en gegevens in het ingebouwde 
geheugen verwijderd.
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samsung media studio
Samsung Media Studio is een gebruiksvriendelijke softwaretoepassing 
voor het ordenen van muziek-, foto-, video- en andere bestanden op 
uw computer. Nadat uw bestanden zijn geordend in Media Studio, kunt 
u deze in een handomdraai overzetten naar uw MP3-speler, zonder dat 
u de hele vaste schijf hoeft te doorzoeken voor het juiste bestand.

SYSTEEMVEREISTEN
Uw computersysteem moet voldoen aan de volgende minimum specifi caties 
voor installatie en gebruik van Media Studio:
• Pentium 500MHz of hoger
• USB 2.0-poort
• Windows XP Service Pack 2 of hoger
• DirectX 9.0 of hoger
• 100 MB vrije schijfruimte
• Cd-romstation (2x of hoger)
• Windows Media Player 10.0 of hoger
• Resolutie 1024 X 768 of hoger
• Internet Explorer 6.0 of hoger
• 512 MB RAM of hoger
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SAMSUNG MEDIA STUDIO INSTALLEREN
Voer het installatieprogramma van <Media Studio> uit via de beheerdersaccount 
op uw computer. Anders wordt <Media Studio> niet geïnstalleerd. Meer informatie 
over het gebruik van de beheerdersaccount vindt u in de gebruiksaanwijzing van uw 
computer.

1. Plaats de installatie-cd die bij de speler is 
geleverd in het cd-romstation.

2. Klik op <Install now> (Nu installeren).

3. Klik op <NEXT> (Volgende).
De installatie van <Media Studio> wordt gestart. 
Wanneer de installatie is voltooid,  verschijnt 
een pictogram op uw bureaublad.

LET OP

Next >
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BESTANDEN OVERBRENGEN NAAR DE SPELER MET 
SAMSUNG MEDIA STUDIO
Met <Media Studio> kunt u bestanden en mappen selecteren en ordenen voordat 
u deze overbrengt naar de speler. Het opzoeken van bestanden op uw MP3-speler 
wordt hierdoor versneld en vereenvoudigd. <Media Studio> biedt de handigste 
manier om uw bestanden van uw computer over te zetten naar uw MP3-speler.

Voordat u begint! - Verwijder de oortelefoon voordat u de USB-kabel aansluit.

1. Sluit het andere (grotere) uiteinde van de USB-kabel aan op de USB-
aansluiting aan de onderkant van de speler.

2. Sluit de USB-kabel aan op de USB-poort ( ) van de computer.
Op het aanraakscherm van de speler wordt <USB connected>(USB aangesloten) 
weergegeven.
<Media Studio> wordt automatisch gestart op het moment dat de speler wordt 
aangesloten op de computer.
Als het programma niet automatisch wordt gestart, dubbelklikt u op het pictogram 
<Media Studio> op het bureaublad.

De technologie voor het herkennen van muziek en verwante gegevens wordt 
geleverd door Gracenote en Gracenote CDDB® Music Recognition ServiceSM.
CDDB is een gedeponeerd handelsmerk van Gracenote. Het logotype en logo 
van Gracenote, Gracenote CDDB en het logo “Powered by Gracenote CDDB” zijn 
gedeponeerde handelsmerken van Gracenote. Music Recognition Service en MRS 
zijn servicemerken van Gracenote. 

1
2

OPMERKING
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BESTANDEN OVERBRENGEN NAAR DE SPELER MET 
SAMSUNG MEDIA STUDIO (vervolg)
3. Klik op het pictogram voor het type bestand 

dat u wilt overbrengen.
Klik op  om de muzieklijst weer te geven.

Klik op  om de videolijst weer te geven.

Klik op  om de afbeeldingenlijst weer te 
geven.

Klik op  om de ETC-lijst weer te geven. 
De ETC-lijst bevat andere bestandstypen 
(bijvoorbeeld .txt) dan muziek-, afbeeldings- en 
videobestanden.

4. Klik op <Add File> (Bestand toevoegen) onder in 
<Media Studio>.

Het venster <Open> (Openen) wordt weergegeven.

5. Selecteer de bestanden die u wilt toevoegen en 
klik op <Open> (Openen).

De bestanden worden aan de lijst aan de linkerzijde van 
het scherm <Media Studio> toegevoegd.

6. Selecteer het bestand dat u wilt overzetten in 
de lijst aan de linkerkant.

7. Klik op het pictogram .
Het geselecteerde bestand wordt overgebracht 
naar de speler.

5

[YP-T10 [MTP]]

Portable [YP-T10[MTP]]3

4

7

6 [YP-T10 [MTP]]

Portable [YP-T10[MTP]]
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BESTANDEN OVERBRENGEN NAAR DE SPELER MET 
SAMSUNG MEDIA STUDIO (vervolg)

Koppel de USB-kabel niet los tijdens de bestandsoverdracht. Loskoppelen van 
de USB-connector tijdens bestandsoverdracht kan leiden tot beschadiging van de 
speler en de computer.
Sluit de speler rechtstreeks op de computer aan in plaats van via een USB-hub. 
Zo voorkomt u een instabiele verbinding.

Wanneer u een videobestand naar de speler overbrengt met <Media Studio>, wordt 
het bestand vóór de overdracht geconverteerd naar de indeling SVI. Tevens wordt 
de bestandsgrootte aangepast. 
Wanneer u een afbeelding naar de speler overbrengt met <Media Studio>, wordt 
het bestand vóór de overdracht geconverteerd naar JPG-indeling. Tevens wordt de 
bestandsgrootte aangepast.
Een afbeelding die u naar de speler overbrengt zonder <Media Studio>, kan er op 
het scherm anders uitzien dan de originele afbeelding.
Zolang de speler is aangesloten op de computer, zijn alle functies uitgeschakeld.
Als u de USB-kabel op de computer aansluit terwijl de batterij bijna leeg is, wordt de 
speler eerst enkele minuten opgeladen voordat de verbinding met de computer tot 
stand wordt gebracht.
Samsung Media Studio heeft een uitgebreide Help-functie. Als u het antwoord op 
uw vraag over Media Studio hier niet kunt vinden, klikt u op <MENU> <Help>
<Help> aan de bovenkant van het venster van <Media Studio>.
Wat is SVI?
Samsung Audio Video Interleaving (SVI) is een nieuwe video-indeling, ontwikkeld 
door en in beheerd van Samsung.

LET OP

OPMERKING
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muziek beluisteren
Voordat u begint! - De oortelefoon aansluiten, de speler aanzetten en de batterij controleren.

Tik op [ ] om naar het vorige scherm te gaan.
Houd [ ] iets langer ingedrukt om naar het scherm met het hoofdmenu te gaan.

LUISTEREN OP CATEGORIE
1. Houd [ ] iets langer ingedrukt om naar het scherm met het 

hoofdmenu te gaan.
2. Tik op [ ] om <Music> (Muziek) te selecteren en tik 

vervolgens op [ ].
De <Music> (Muziek) lijst wordt weergegeven.

3. Tik op [ ] om de gewenste lijst te selecteren en tik op [ ].
Het muziekbestand wordt weergegeven.

4. Tik op [ ] om het bestand te selecteren dat u wilt afspelen 
en tik op [ ].

De muziek wordt afgespeeld.
Muzieklijst
Bestandsinformatie, waaronder naam van de artiest, naam van het album, titel van het nummer en het 
genre worden weergegeven, gebaseerd op de ID3-taginformatie bij het muziekbestand. Bestanden 
zonder ID3-Tag worden weergegeven als <Unknown> (onbekend).
Now Playing (Nu Speelt) : Speelt een recent afgespeeld bestand of gaat naar het afspeelscherm 
van het huidige bestand.
Artists (Artiest) : Afspelen op artiest                 Albums (Album) : Afspelen op album
Songs (Nummers) : Afspelen in numerieke of alfabetische volgorde           
Genres (Genre) : Afspelen op genre                 Playlists : Afspelen op afspeellijst
Recorded Files (Opgenomen bestanden) : toont alle opgenomen bestanden.
Music Browser (Muziekbrowser) : Geeft alle muziekbestanden in de muziekmap weer.

De speler kan MP3- en WMA-muziekbestanden afspelen.
MP1- of MP2-bestanden waarvan alleen de extensie is gewijzigd in MP3, kunnen niet 
worden afgespeeld op de speler.
Wat is een ID3-parameter?
Dit is een tag in een MP3-bestand die informatie bevat over het bestand, zoals de titel, de 
artiest, het album, het jaar, het genre en een veld voor opmerkingen.

OPMERKING

OPMERKING

Now Playing
Artists
Albums
Songs
Genres
Playlists
Recorded Files
Music Browser

Music



36 _ muziek beluisteren

PAUZEREN
1. Tik op [ ] terwijl de muziek wordt afgespeeld.

Het afspelen van de muziek wordt onderbroken.

2. Tik nogmaals op [ ].
De muziek wordt afgespeeld vanaf het punt waar het afspelen is gestopt.

ZOEKEN BINNEN EEN NUMMER
1. Houd [ ] kort ingedrukt terwijl het geselecteerde nummer wordt 

afgespeeld.
Er wordt gezocht richting het begin of het einde van het nummer.

2. Laat de toets los op het punt waar u wilt starten.
Het nummer wordt afgespeeld vanaf het moment dat u de toets loslaat.

AFSPELEN VANAF HET BEGIN VAN HET HUIDIGE NUMMER
1. Tik na 3 seconden afspelen op [ ].

Het huidige nummer wordt afgespeeld vanaf het begin.

HET VORIGE NUMMER AFSPELEN
Tik binnen 3 seconden afspelen op  [ ].
Tik na 3 seconden afspelen tweemaal op [ ].

Het vorige nummer wordt afgespeeld.

HET VOLGENDE NUMMER AFSPELEN
Tik op  [ ].

Het volgende nummer wordt afgespeeld.
In het geval van een VBR-bestand kan het vorige muziekbestand niet worden 
afgespeeld, ook niet als u binnen 3 seconden nadat dit bestand is gestart op [ ] tikt. LET OP



muziek beluisteren _ 37

EEN AFSPEELLIJST MAKEN MET SAMSUNG MEDIA 
STUDIO
Met <Media Studio> kunt u uw eigen collectie of afspeellijst met 
geluidsbestanden samenstellen.

Voordat u begint! - Sluit de speler aan op de computer.
Media Studio moet zijn geïnstalleerd op de computer.

Een afspeellijst maken

1. Klik op <Playlists> boven in <Media Studio>.
Het venster <Playlists> wordt weergegeven.

2. Klik onder in het venster op <New Playlists> (Nieuwe 
afspeellijsten).

Het venster <Create Playlists> (Afspeellijsten maken) wordt weergegeven.
3. Geef een titel voor de afspeellijst op en klik op <OK>.

De nieuwe afspeellijst krijgt een naam en wordt opgeslagen in het gedeelte 
<Playlists> in <Media Studio>.

2

1
[YP-T10 [MTP]]

OK 3

Portable [YP-T10[MTP]]
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EEN AFSPEELLIJST MAKEN MET SAMSUNG MEDIA 
STUDIO (vervolg)

Muziekbestanden toevoegen aan een afspeellijst die 
u hebt gemaakt

1. Klik op <My PC> (Mijn PC) boven in <Media Studio>.
Het venster <My PC> (Mijn PC) wordt weergegeven.

2. Klik op <Playlists> in de rechterhoek van het venster.
Het venster <Playlists> wordt weergegeven.

3. Dubbelklik op een album in het rechtervenster.
4. Selecteer in het venster <My PC> (Mijn PC) de bestanden die u wilt 

overbrengen.
5. Klik op het symbool .

De geselecteerde bestanden worden aan de afspeellijst toegevoegd.

5

1

3
4

2
[YP-T10 [MTP]]
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EEN AFSPEELLIJST MAKEN MET SAMSUNG MEDIA 
STUDIO (vervolg)

Een afspeellijst kopiëren naar de speler met Media 
Studio

1. Klik op <Playlists> boven in <Media Studio>.
Het venster <Playlists> wordt weergegeven.

2. Selecteer een afspeellijst in het gedeelte <Playlists>.
3. Klik op het symbool .

De geselecteerde afspeellijst wordt map voor map overgezet naar 
<File Browser> (Bestandsbrowser)  <Playlists>.

De speler kan maximaal 400 afspeellijsten afspelen met maximaal 400 
muziekbestanden per afspeellijst.

1
[YP-T10 [MTP]]

32

Portable [YP-P2[MTP]]

OPMERKING
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EEN AFSPEELLIJST OP UW MP3-SPELER MAKEN
Als u al bestanden hebt gedownload naar uw MP3-speler, kunt u een afspeellijst 
met ‘Favorieten’ samenstellen zonder Media Studio op uw pc.
1. Houd [ ] iets langer ingedrukt om naar het scherm met 

het hoofdmenu te gaan.
2. Tik op [ ] om <File Browser> (Bestandsbrowser) te 

selecteren en tik vervolgens op [ ].
3. Tik op [ ] om <Music> (Muziek) te selecteren en tik 

vervolgens op [ ].
De lijst met muziekbestanden wordt weergegeven.

4. Tik op [ ] om een bestand te selecteren dat u wilt 
toevoegen aan uw lijst met favorieten en tik vervolgens op 
[ ].

Het menu Afspeellijst wordt weergegeven.

5. Tik op [ ] om <Add to Playlist> (Toev. aan afsp.) te 
selecteren en tik vervolgens op [ ].

<Playlist 1>(Afspeellijst 1) tot en met <Playlist 5>(Afspeellijst 5) 
wordt weergegeven.

6. Tik op [ ] om een afspeellijstnummer te selecteren 
waaraan u het geselecteerde bestand wilt toevoegen en tik 
vervolgens op [ ].

Het geselecteerde bestand wordt aan de afspeellijst toegevoegd.
U kunt de afspeellijst bekijken via <Music>(Muziek)  <Playlists>  <Playlist 
1>(Afspeellijst 1) tot en met <Playlist 5> 
(Afspeellijst 5) in het hoofdmenu.

U kunt maximaal 200 muziekbestanden toevoegen aan elke afspeellijst 
(<Playlist 1>(Afspeellijst 1) tot en met <Playlist 5>(Afspeellijst 5)).OPMERKING

Add to Playlist

 Playlist 1
 Playlist 2
 Playlist 3
 Playlist 4
 Playlist 5
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EEN AFSPEELLIJST AFSPELEN
1. Houd [ ] iets langer ingedrukt om naar het scherm met 

het hoofdmenu te gaan.
2. Tik op [ ] om <Music> (Muziek) te selecteren en tik 

vervolgens op [ ].
De muzieklijst wordt weergegeven.

3. Tik op [ ] om <Playlists> te selecteren en tik 
vervolgens op [ ].

De afspeellijsten worden weergegeven.

4. Tik op [ ] om de gewenste afspeellijst te selecteren en 
tik op [ ].

De muziekbestanden die in de geselecteerde afspeellijst zijn 
opgeslagen, worden weergegeven.
Als geen afspeellijst wordt gevonden, wordt de melding <No File> 
(Geen bestanden.) op het scherm weergegeven.

5. Tik op [ ] om het muziekbestand te selecteren dat u 
wilt afspelen en tik op [ ].

Het muziekbestand wordt afgespeeld.

Zie pagina’s 37 en 39 voor meer informatie over hoe u een afspeellijst overbrengt 
met <Media Studio>.

Now Playing
Artists
Albums
Songs
Genres
Playlists
Recorded Files
Music Browser

Music

OPMERKING

Playlist 1
Playlist 2
Playlist 3
Playlist 4
Playlist 5

Playlists
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EEN BESTAND VERWIJDEREN UIT DE AFSPEELLIJST
1. Houd [ ] iets langer ingedrukt om naar het scherm met 

het hoofdmenu te gaan.
2. Tik op [ ] om <Music> (Muziek) te selecteren en tik 

vervolgens op [ ].
De muzieklijst wordt weergegeven.

3. Tik op [ ] om <Playlists> (Playlists) te selecteren en 
tik vervolgens op [ ].

De afspeellijsten worden weergegeven.
4. Tik op [ ] om de gewenste afspeellijst te selecteren en 

tik op [ ].
De muziekbestanden die in de geselecteerde afspeellijst zijn opgeslagen, worden 
weergegeven.

5. Tik op [ ] om een bestand te selecteren dat u uit de afspeellijst wilt 
verwijderen en tik op [ ].

Het menu Afspeellijst wordt weergegeven.
6. Tik op [ ] om <Delete from Playlist> (Verw. uit afspeellijst) te selecteren 

en tik vervolgens op [ ].
Het geselecteerde bestand wordt verwijderd uit de afspeellijst.

Het geselecteerde bestand kan niet worden verwijderd als deze wordt afgespeeld.

ALLE BESTANDEN VERWIJDEREN UIT DE AFSPEELLIJST
Volg stap 1 tot en met 4 hierboven.
5. Tik op [ ].

Het menu Afspeellijst wordt weergegeven.

6. Tik op [ ] om <Delete All from Playlist> (Alles verw. 
uit afsp.lijst) te selecteren en tik vervolgens op [ ].

Alle bestanden worden uit de afspeellijst verwijderd.

Delete from Playli..
Delete All from Pl...

Delete from Playli..
Delete All from Pl...

OPMERKING
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HET MUZIEKMENU GEBRUIKEN
Via het menu Muziek heeft u controle over alle facetten van het luisteren 
naar muziek; van het herhalen van nummers en albums tot het kiezen van de 
schermachtergrond tijdens het afspelen van muziek.

Het geluidseffect instellen
U kunt genieten van helderder geluid.
1. Tik op [ ] terwijl u naar muziek luistert.

Het menu <Music>(Muziek) wordt weergegeven.

2. Tik op [ ] om <Sound Effect> (Geluidseffect) 
te selecteren en tik vervolgens op [ ].

Het menu <Sound Effect>(Geluidseffect) wordt 
weergegeven.

3. Tik op [ ] om het gewenste geluidseffect te 
selecteren en tik op [ ].

Opties voor geluidseffecten
Street Mode (Straatmodus) : In deze modus kunt u ook buiten luisteren naar 
muziek met een helder geluid, doordat straatgeluiden gefi lterd worden. U kunt 
kiezen uit <Off>(Uit) en <On>(Aan).
Clarity (Helderheid) : Geniet van een helderder geluid met verbeterde kwaliteit. 
Kies uit 0-2 <0-2>.

Tik op [ ] om het menu te verlaten.

Sound Effect
DNSe
Play Mode
Music Play Screen
Play Speed
Skip Interval
Connect to Heads..

OPMERKING
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HET MUZIEKMENU GEBRUIKEN (Vervolg)
De Digital Natural Sound-engine (DNSe) instellen (DNSe)
Hier selecteert u de juiste geluidsweergave voor elk muziekgenre.
1. Tik op [ ] terwijl u naar muziek luistert.

Het menu <Music>(Muziek) wordt weergegeven.

2. Tik op [ ] om <DNSe> te selecteren en tik 
vervolgens op [ ].

Het menu <DNSe> (DNSe) wordt weergegeven.

3. Tik op [ ] om een gewenste DNSe te 
selecteren en tik op [ ].

U kunt kiezen uit <Normal>(Normaal), <Studio>, 
<Rock>, <Classical>(Klassiek), <Jazz>, <Ballad>, 
<Club>, <Rhythm & Blues>, <Dance>, <Concert Hall> (Concertzaal) en 
<User>(Gebruiker).
U kunt <EQ> (EQ) en <3D&Bass>(3D en bas) instellen als u <User> 
(Gebruiker) hebt geselecteerd. Zie pagina 59

Wat is DNSe?
Digital Natural Sound Engine (DNSe) is een functie voor geluidseffecten 
voor MP3-spelers die is ontwikkeld door Samsung. Dit biedt verschillende 
geluidsinstellingen voor het verbeteren van het type muziek waar u naar 
luistert.

OPMERKING
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HET MUZIEKMENU GEBRUIKEN (Vervolg)
De Digital Natural Sound-engine (DNSe) instellen
<EQ> (EQ)
U kunt de individuele geluidsfrequenties naar wens instellen.
1 Tik op [ ] in het menu DNSe om <User>

(Gebruiker) te selecteren en tik op [ ].
2. Tik op [ ] om <EQ> te selecteren en tik 

vervolgens op [ ].
Het instellingenscherm <EQ> wordt weergegeven.

3. Tik op [ ] om de frequentie te selecteren die u wilt 
aanpassen en tik vervolgens op [ ] om het niveau 
van de geselecteerde frequentie aan te passen.

U kunt voor <EQ> kiezen uit -10 tot +10.
4. Tik op  [ ].

De instelling is voltooid.

<3D&Bass> (3D en BAS)
U kunt het 3D-surroundgeluid en het basniveau instellen.
1. Tap [ ] in the DNSe menu to select <User>

and tap [ ].
2. Tik op [ ] om <3D & BASS> (3D en BAS) te 

selecteren en tik vervolgens op [ ].
Het instellingenscherm <3D & BASS>(3D en BAS) wordt 
weergegeven.

3. Tik op [ ] om <3D> of <BASS> (BAS) te 
selecteren en tik op [ ].

U kunt voor <3D> en voor <BASS> (BAS) een niveau 
selecteren van 0 tot 4.

4. Tik op  [ ].
De instelling is voltooid.

EQ  >
3D & BASS

EQ  >
3D & BASS >
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HET MUZIEKMENU GEBRUIKEN (Vervolg)
De afspeelmodus instellen
De afspeelmodus selecteren, zoals de herhaalinstellingen.
1. Tik op [ ] terwijl u naar muziek luistert.

Het menu <Music>(Muziek) wordt weergegeven.

2. Tik op [ ] om <Play Mode> (Afspeelmodus) te 
selecteren en tik vervolgens op [ ].

Het menu <Play Mode>(Afspeelmodus) wordt 
weergegeven.

3. Tik op [ ] om de gewenste modus te 
selecteren en tik op [ ].

U hebt de keuze uit <Normal>(Normaal), <Repeat>(Herhaal), <Repeat 
One>(Eén herhalen) of <Shuffl e> (Shuffl e).

Opties voor afspeelmodus
Normal (Normaal) :  Alle nummers worden één keer in de normale volgorde 

afgespeeld.
Repeat (Herhaal) : Om alle bestanden in de huidige map te herhalen.
Repeat One (Eén herhalen) : Eén bestand wordt herhaald..
Shuffl e (Shuffl e): Bestanden worden in willekeurige volgorde afgespeeld.
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HET MUZIEKMENU GEBRUIKEN (Vervolg)
Het muziekafspeelscherm selecteren
Kies een achtergrondafbeelding uit de geboden mogelijkheden of kies 
uw eigen achtergrondafbeelding. Deze wordt weergegeven terwijl u 
naar muziek luistert.
1. Tik op [ ] terwijl u naar muziek luistert.

Het menu <Music>(Muziek) wordt weergegeven.
2. Tik op [ ] om <Music Play Screen>

(Muziekafspeelscherm) te selecteren en tik 
vervolgens op [ ].

Het menu <Music Play Screen> 
(Muziekafspeelscherm) wordt weergegeven.

3. Tik op [ ] om een gewenst muziekafspeelscherm 
te selecteren en tik vervolgens op [ ].

U kunt kiezen uit <Type 1>, <Type 2>, <Type 3>, 
<Type 4>, <Album Art>(Albumontw.) en <Album Info.>(Albuminfo.). 

Opties voor muziekafspeelscherm
Type 1 ~ Type 4 (Type 1 ~ Type 4) : U kunt een muziekafspeelscherm naar 
keuze selecteren.
Album Info. (Albuminfo.) : Informatie over de naam van de artiest, het album 
en het genre wordt weergegeven als ID3-taginformatie is opgeslagen in het 
muziekbestand.
Album Art (Albumontw.) : Een afbeelding van de cd-hoes wordt weergegeven 
als deze informatie is opgenomen in de ID3-taginformatie van het 
muziekbestand. Afbeeldingen van cd-hoesjes worden ondersteund als deze niet 
groter zijn dan 200 pixels (horizontaal) x 200 pixels (verticaal).

Als u in <Menu Design> (Menuontwerp) de optie <Sammy> instelt, kan de 
functie <Album Art > (Albumontw.) niet worden weergegeven.
Wat is een ID3-parameter?
Dit is een tag in een MP3-bestand die informatie bevat over het bestand, zoals 
de titel, de artiest, het album, het jaar, het genre en een veld voor opmerkingen.
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HET MUZIEKMENU GEBRUIKEN (Vervolg)
De afspeelsnelheid instellen
U kunt de afspeelsnelheid van uw favoriete muziek versnellen of vertragen.
1. Tik op [ ] terwijl u naar muziek luistert.

Het menu <Music>(Muziek) wordt weergegeven.
2. Tik op [ ] om <Play Speed> (Afspeelsnelheid) te 

selecteren en tik vervolgens op [ ].
Het menu <Play Speed>(Afspeelsnelheid) wordt 
weergegeven.

3. Tik op [ ] om een gewenst afspeelsnelheid te 
selecteren en tik vervolgens op [ ].

U kunt kiezen uit <X 0.7>, <X0.8>, <X 0.9>, 
<X 1.0(Normaal)>, <X 1.1>, <X 1.2> en <X 1.3>. 
Hoe hoger het getal, des te sneller de afspeelsnelheid.

Afhankelijk van het bestand kan de aangepaste snelheid afwijken van de 
ingestelde snelheid.

Het interval voor overslaan instellen
U kunt snel vooruit door een bestand bladeren met verschillende intervallen. 
Sla een heel bestand over of meerdere seconden tegelijkertijd.
1. Tik op [ ] terwijl u naar muziek luistert.

Het menu <Music>(Muziek) wordt weergegeven.
2. Tik op [ ] om <Skip Interval>

(Tijdsverschuivingsinterval) te selecteren en tik 
vervolgens op [ ].

Het menu <Skip interval>(Tijdsverschuivingsinterval) wordt 
weergegeven.

3. Tik op [ ] om een gewenste tijdverschuivingsinterval 
te selecteren en tik vervolgens op [ ].

U kunt kiezen uit <1 Song>, <5sec>, <10sec>, <30sec> en 
<1min>.

Als het bestand is opgenomen met een variabele bitrate, komt 
het tijdverschuivingsinterval mogelijk niet precies overeen met wat u hebt ingesteld.OPMERKING
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HET MUZIEKMENU GEBRUIKEN (Vervolg)
Voordat u begint! - Gebruik alleen stereokoptelefoons die zijn gecertifi ceerd voor 
Bluetooth. Controleer of uw Bluetooth-stereokoptelefoon is geregistreerd. <Connect 
to Headset> (Verb. met koptelefoon) wordt weergegeven als er een geregistreerde 
koptelefoon aanwezig is. Zie <Een Bluetooth-stereokoptelefoon gebruiken> voor 
meer informatie. Zie pagina 79

Verbinding maken met een Bluetooth-stereokoptelefoon
U kunt tijdens het afspelen van muziek rechtstreeks verbinding maken 
met de geregistreerde Bluetooth-koptelefoon.
1. Tik op [ ] terwijl u naar muziek luistert.

Het menu <Music>(Muziek) wordt weergegeven.

2. Tik op [ ] om <Connect to Headset> (Verb. met 
koptelefoon) te selecteren en tik vervolgens op [ ].

Als <Bluetooth Mode> is ingesteld op <Off>(UIT), 
wordt dit gewijzigd in <On>(AAN).
Wanneer de verbinding tot stand is gebracht, ziet u het 
pictogram [ ] op het scherm.
U kunt met de Bluetooth-koptelefoon naar muziek 
luisteren.

De verbinding met de Bluetooth-stereokoptelefoon 
verbreken
1. Tik op [ ] terwijl u naar muziek luistert.

Het menu <Music>(Muziek) wordt weergegeven.

2. Tik op [ ] om <Disconnect Headset>
(Headset loskoppelen) te selecteren en tik 
vervolgens op [ ].

De verbinding met de Bluetooth-koptelefoon is 
verbroken.

Sommige menu’s kunnen niet worden geselecteerd 
terwijl de speler verbinding maakt met de Bluetooth-
stereokoptelefoon.
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een video bekijken
Voordat u begint! - De koptelefoon aansluiten, de speler aanzetten en de batterij 
controleren. Een videobestand naar de speler overbrengen. 
De lijst met video's wordt weergegeven. Zie pagina 32~34
Tik op [ ] om naar het vorige scherm te gaan.
Houd [ ] iets langer ingedrukt om naar het scherm met het 
hoofdmenu te gaan.

1. Houd [ ] iets langer ingedrukt om naar het scherm met 
het hoofdmenu te gaan.

2. Tik op [ ] om <Videos> (Video’s) te selecteren en tik 
vervolgens op [ ].

De lijst met video’s wordt weergegeven.

3. Tik op [ ] om het videobestand te selecteren dat u wilt 
afspelen en tik op [ ].

Het geselecteerde videobestand wordt horizontaal afgespeeld.

HET AFSPELEN ONDERBREKEN
1. Tik op [ ] terwijl een videobestand wordt afgespeeld.

Het afspelen wordt onderbroken.

2. Tik nogmaals op [ ].
Het afspelen wordt hervat vanaf het punt waarop het werd onderbroken.

Wanneer u een videobestand naar de speler overbrengt met <Media Studio>, wordt 
het bestand vóór de overdracht geconverteerd naar de indeling SVI. Tevens wordt 
de bestandsgrootte aangepast.

OPMERKING

OPMERKING
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NAAR EEN SPECIFIEK FRAME GAAN
1. Houd [ ] in de horizontale weergave kort 

ingedrukt.
Hierdoor kunt u in het huidige videobestand vooruit en 
achteruit spoelen.

2. Haal uw vinger van de toets nadat u naar de 
gewenste positie hebt gespoeld.

De video begint op dit punt af te spelen.

HET VORIGE VIDEOBESTAND AFSPELEN
1. Tik binnen 3 seconden nadat het huidige bestand is 

begonnen met afspelen op [ ].
Tik 3 seconden nadat het huidige bestand is 
begonnen met afspelen tweemaal op [ ].

De vorige video wordt nu afgespeeld.

HET VOLGENDE VIDEOBESTAND AFSPELEN
1. Tik op  [ ].

Het volgende bestand wordt nu afgespeeld.

Video Track 1

Video Track 1

Video Track 2
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HET VIDEOMENU GEBRUIKEN
Tik op [ ] om het menu te verlaten. 

De helderheid wijzigen
U kunt de helderheid van het scherm aanpassen.
1. Tik op [ ] terwijl een videobestand wordt 

afgespeeld.
Het menu <Video> wordt weergegeven.

2. Tik op [ ] om <Brightness> (Helderheid) 
te selecteren en tik vervolgens op [ ].

Het menu <Brightness> (Helderheid) wordt 
weergegeven.

3. Tik op [ ] om de gewenste helderheid te selecteren en tik op [ ].
U kunt kiezen uit <0~10>.

De Digital Natural Sound-engine (DNSe) instellen
De juiste geluidsweergave voor elk videogenre selecteren.
1. Tik op [ ] terwijl een videobestand wordt 

afgespeeld.
Het menu <Video> wordt weergegeven.

2. Selecteer <DNSe> en tik op [ ].
Het menu <DNSe> wordt weergegeven.

3. Tik op [ ] om een gewenste DNSe te 
selecteren en tik op [ ].

U kunt kiezen uit <Normal>(Normaal), <Drama>(Drama) en <Action>(Hand.).

Wat is SVI?
Digital Natural Sound Engine (DNSe) is een functie voor geluidseffecten voor MP3-
spelers die is ontwikkeld door Samsung. Dit biedt verschillende geluidsinstellingen 
voor het verbeteren van het type muziek waar u naar luistert.

Brightness
DNSe
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HET VIDEOMENU GEBRUIKEN (Vervolg)
Voordat u begint! - Gebruik alleen stereokoptelefoons die zijn 
gecertifi ceerd voor Bluetooth. Controleer of uw Bluetooth-stereokoptelefoon 
is geregistreerd. <Connect to Headset> (Verb. met koptelefoon) wordt 
weergegeven als er een geregistreerde koptelefoon aanwezig is. Zie <Een 
Bluetooth-stereokoptelefoon gebruiken> voor meer informatie. Zie pagina 79.

Verbinding maken met een Bluetooth-stereokoptelefoon
U kunt tijdens het afspelen van video rechtstreeks verbinding maken 
met een geregistreerde Bluetooth-koptelefoon.
1. Tik op [ ] terwijl een videobestand wordt 

afgespeeld.
Het menu <Video> wordt weergegeven.

2. Selecteer <Connect to Headset> (Verb. 
met koptelefoon) en tik op [ ].

Als <Bluetooth Mode>(Bluetooth Mode) is ingesteld 
op <Off>(Uit), wordt dit gewijzigd in <On>(Aan).
Wanneer de verbinding tot stand is gebracht, 
ziet u het pictogram [ ] op het scherm.
U kunt via de stereokoptelefoon genieten van videogeluid.

De verbinding met de Bluetooth-stereokoptelefoon verbreken
1. Tik op [ ] terwijl een videobestand wordt 

afgespeeld.
Het menu <Video> wordt weergegeven.

2. Selecteer <Disconnect Headset>
(Headset loskoppelen) en tik op [ ].

De verbinding met de Bluetooth-koptelefoon is 
verbroken.

Sommige menu’s kunnen niet worden geselecteerd terwijl de speler verbinding 
maakt met de Bluetooth-stereokoptelefoon.

Brightness
DNSe
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Disconnect Headset
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afbeeldingen bekijken
Voordat u begint! - De oortelefoon aansluiten, de speler aanzetten en de batterij controleren.
Tik op [ ] om naar het vorige scherm te gaan.
Houd [ ] iets langer ingedrukt om naar het scherm met het hoofdmenu te gaan.

1. Houd [ ] iets langer ingedrukt om naar het scherm met 
het hoofdmenu te gaan.

2. Tik op [ ] om <Pictures> (Afbeeld.) te selecteren en tik 
vervolgens op [ ].

Het voorbeeldscherm voor afbeeldingen wordt weergegeven.

3. Tik op [ ] om de afbeelding te selecteren die u wilt 
bekijken en tik op [ ].

De geselecteerde afbeelding wordt weergegeven.

Tik op [ ] om naar het vorige venster te gaan.

Naar de vorige/volgende afbeelding gaan
1. Tik in horizontale weergave op [ ].

De vorige/volgende afbeelding wordt weergegeven.

In  wordt een JPG-bestand weergegeven, inclusief onjuiste 
miniatuurweergavegegevens.
Sommige afbeeldingen worden langzamer weergegeven dan andere.
Wanneer u een afbeelding naar de speler overbrengt met <Media Studio>, wordt 
het bestand vóór de overdracht geconverteerd naar JPG-indeling. Tevens wordt de 
bestandsgrootte aangepast.
U kunt ook een afbeelding zoeken met behulp van de <File Browser> 
(Bestandsbrowser). Zie pagina 21.
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OPMERKING

HET AFBEELDINGSMENU GEBRUIKEN
Tik op [ ] om het menu te verlaten.

Naar muziek luisteren terwijl u een foto bekijkt.
U kunt naar het laatst afgespeelde nummer luisteren terwijl u een foto 
bekijkt.
1. Tik op [ ] terwijl u een foto bekijkt.

Het menu <Picture>(Afbeeld.) wordt weergegeven.

2. Tik op [ ] om <Music> (Muziek) te 
selecteren en tik vervolgens op [ ].

Het menu <Music>(Muziek) wordt weergegeven. 

3. Tik op [ ] om <Off> (UIT) of <On>
(AAN) te selecteren en tik op [ ].

<Off> (Uit): Er wordt geen achtergrondmuziek gespeeld terwijl u een foto bekijkt.
<On> (Aan): U kunt naar het laatst afgespeelde nummer luisteren terwijl u 

een foto bekijkt.

Een diashow bekijken

Instructie 1
1. Tik op [ ] terwijl u een foto bekijkt.

U ziet   op het scherm en vervolgens wordt de 
diashow gestart.

Instructie 2
1. Tik op [ ] in de voorbeeldmodus voor afbeeldingen.

Het venster Diashow starten wordt weergegeven.

2. Tik op [ ].
U ziet  op het scherm en vervolgens wordt de diashow gestart.

Music
Start Slideshow
Slideshow Speed
Zoom
Rotate
Select as My Skin

Start Slideshow
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HET AFBEELDINGSMENU GEBRUIKEN (Vervolg)
De diashow beëindigen

Instructie 1
1. Tik tijdens de diashow op [ ].

De diashow wordt gestopt.

Instructie 2
1. Tik tijdens de diashow op [ ].

Het menu <Picture>(Afbeeld.) wordt 
weergegeven.

2. Tik op [ ] om <Stop Slideshow> (Diavoorstelling stoppen) te 
selecteren en tik vervolgens op [ ].

De diashow wordt gestopt.

De afspeelsnelheid van de diashow instellen
1. Tik op [ ] terwijl u een foto bekijkt.

Het menu <Picture>(Afbeeld.) wordt 
weergegeven.

2. Tik op [ ] om <Slideshow Speed>
(Snelheid diavoorst.) te selecteren en tik 
vervolgens op [ ].

Het menu <Slideshow speed> (Snelheid 
diavoorst.) wordt weergegeven.

3. Tik op [ ] om de gewenste snelheid te selecteren en tik op [ ].
U kunt kiezen uit <Fast>(Snel), <Normal>(Normaal) en <Slow>(Traag).
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HET AFBEELDINGSMENU GEBRUIKEN (Vervolg)
Een afbeelding vergroten
U kunt inzoomen op een afbeelding.
1. Tik op [ ] terwijl u een foto bekijkt.

Het menu <Picture>(Afbeeld.) wordt weergegeven.
2. Tik op [ ] om <Zoom> te selecteren en 

tik vervolgens op [ ].
Het menu <Zoom> wordt weergegeven.

3. Tik op [ ] om een gewenste 
vergrotingsfactor te selecteren en tik 
vervolgens op [ ].

U kunt kiezen uit <100%>, <200%> en <400%>.
4. Tik op [ ] om naar het gedeelte van de afbeelding te gaan 

dat u wilt vergroten.

Het zoomen annuleren
Instructie 1
1. Tik op [ ] in de vergrootte weergave van 

een afbeelding.
Hiermee keert u terug naar de normale afmeting.

Instructie 2
1. Tik in de vergrootte weergave van een 

afbeelding op [ ].
Het menu <Picture>(Afbeeld.) wordt weergegeven.

2. Tik op [ ] om <Zoom> te selecteren en tik vervolgens op [ ].
Het menu <Zoom> wordt weergegeven.

3. Tik op [ ] om <100%> te selecteren en tik vervolgens op [ ].
Hiermee keert u terug naar de normale afmeting.

Het kan iets langer duren om in te zoomen op een grote afbeelding.
OPMERKING
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HET AFBEELDINGSMENU GEBRUIKEN (Vervolg)
Een foto draaien
U kunt een afbeelding desgewenst draaien.
1. Tik op [ ] terwijl u een foto bekijkt.

Het menu <Picture>(Afbeeld.) wordt weergegeven.

2. Tik op [ ] om <Rotate> (Draaien) te 
selecteren en tik vervolgens op [ ].

Het menu <Rotate> wordt weergegeven.

3. Tik op [ ] om de gewenste hoek te 
selecteren en tik op [ ].

U kunt kiezen uit <Left 90°>(Links 90°), <Right 90°>(Rechts 90°) en <180°>.

Een afbeelding als achtergrondafbeelding selecteren
U kunt een afbeelding naar keuze instellen als achtergrond voor het scherm.
1. Selecteer het afbeeldingsbestand dat u als 

achtergrondafbeelding wilt instellen.
Het menu <Picture>(Afbeeld.) wordt 
weergegeven.

2. Tik op [ ] om <Select as My Skin>
(Select. als Mijn huid) te selecteren en tik 
vervolgens op [ ].

Het opslagbevestigingsvenster wordt weergegeven.

3. Tik op [ ] om <Yes> (Ja) te selecteren en tik vervolgens op [ ].
De geselecteerde afbeelding wordt ingesteld als achtergrondafbeelding.
Als <My Skin> (Mijn Skin) is geselecteerd in <Settings> (Instellingen)
<Menu Style> (Menustijl)  <Menu Design> (Menuontwerp), wordt de 
ingestelde afbeelding weergegeven.
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naar de FM-radio luisteren
Voordat u begint! - De oortelefoon aansluiten, de speler aanzetten en de batterij 
controleren.
Tik op [ ] om naar het vorige scherm te gaan.
Houd [ ] iets langer ingedrukt om naar het scherm met het hoofdmenu te gaan.

1. Houd [ ] iets langer ingedrukt om naar het scherm met 
het hoofdmenu te gaan.

2. Tik op [ ] om <FM Radio> (FM-radio) te selecteren en 
tik vervolgens op [ ].

FM-radio wordt ontvangen.

DE DEMPFUNCTIE GEBRUIKEN
Tik op [ ] tijdens het luisteren naar de FM-radio.

Het geluid wordt onderdrukt.

Tik nogmaals op [ ] om het geluid weer in te schakelen.

Sluit altijd de oortelefoon aan op uw speler als u frequenties zoekt of instelt. De 
oortelefoon wordt gebruikt als antenne voor het ontvangen van FM-radio.
In gebieden met slechte ontvangst worden mogelijk geen FM-stations gevonden.
De Bluetooth-functie kan niet worden gebruikt tijdens het luisteren naar de radio.

OPMERKING
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FM-STATIONS ZOEKEN
1. Houd [ ] even ingedrukt en laat dan los in de 

handmatige stand.
<Auto Searching....> (Auto Zoeken...) wordt op het scherm 
weergegeven.
Het zoeken stopt bij de eerstvolgende frequentie nadat u de toets 
hebt losgelaten.

OF,

1. Tik op [ ] om de frequenties stap voor stap bij langs te 
gaan in de handmatige stand.

Wanneer u de toets indrukt wordt er naar een frequentie gezocht.

MANUAL

Auto Seaching...

MANUAL



naar de FM-radio luisteren _ 61

HET MENU FM-RADIO GEBRUIKEN
Overschakelen naar de stand met voorinstellingen
Selecteer deze stand als u de opgeslagen FM-voorinstellingen wilt afzoeken.
1. Tik in de handmatige stand op [ ].

Het menu <FM Radio> (FM-radio) wordt weergegeven.

2. Tik op [ ] om <Go to Preset Mode> (Ga naar 
Preset Modus) te selecteren en tik vervolgens op 
[ ].

De <PRESET> wordt op het scherm weergegeven.

Als er geen frequenties vooraf zijn ingesteld, ziet u 
<Preset list does not exist> (Lijst preselectie bestaat 
niet) en schakelt de speler niet over op de <Preset 
Mode> (Stand met voorinstellingen).
Als u <Default Set> (Standaard instellen) selecteert in <Settings> (Instellingen) 

 <System> (Systeem), worden alle vooringestelde frequenties verwijderd.

Overschakelen naar de handmatige stand
Selecteer deze stand als u de FM-band handmatig per frequentie wilt 
afzoeken.
1. Tik in de stand met voorinstellingen op [ ].

Het menu <FM Radio> (FM-radio) wordt weergegeven.

2. Tik op [ ] om <Go to Manual Mode> (Ga naar 
Handm. Modus) te selecteren en tik vervolgens 
op [ ].

De <MANUAL> wordt op het scherm weergegeven.

OPMERKING
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HET MENU FM-RADIO GEBRUIKEN (Vervolg)
Stations opslaan in het voorkeuzegeheugen
U kunt maximaal 30 stations opslaan in het geheugen van uw MP3-
speler en deze vervolgens met één druk op de knop oproepen. Laat de 
MP3-speler met het handmatige proces alleen de zenders kiezen die u 
wilt, of sla automatisch alle gevonden lokale zenders op.
Manual (Handmatig) : alleen de stations kiezen die u wilt opslaan
1. Tik op [ ] om in de handmatige stand de 

gewenste frequentie te selecteren. 
Het menu <FM Radio> (FM-radio) wordt weergegeven.

2. Tik op [ ].
3. Tik op [ ] om <Add to Preset> (Toev. aan 

voorinst.) te selecteren en tik vervolgens op [ ].
De geselecteerde frequentie wordt aan de lijst met 
preselecties toegevoegd met het symbool [ ] op de balk 
met de geselecteerde frequentie.

4. Als u andere frequenties wilt instellen, volgt u stappen 1-3 hierboven.

Als een bepaalde frequentie al is voorgeprogrammeerd, wordt de 
melding <This preset already exists> (Deze preselectie bestaat reeds) 
weergegeven. De instelling wordt geannuleerd.

OPMERKING
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HET MENU FM-RADIO GEBRUIKEN (Vervolg)
Stations opslaan in het voorkeuzegeheugen (vervolg)
Automatisch: automatisch alle zenders opslaan die de speler 
ontvangt
1. Tik in de modus FM Radio op [ ].

Het menu <FM Radio> (FM-radio) wordt weergegeven.

2. Tik op [ ] om <Auto Preset> (Autom. 
voorinst.) te selecteren en tik vervolgens op [ ].

Het bevestigingsvenster wordt weergegeven.

3. Tik op [ ] om <Yes> (Ja) te selecteren en tik 
vervolgens op [ ].

<Auto Preset> (Autom. voorinst.) verschijnt en 
maximaal 30 frequenties worden automatisch ingesteld.

Automatische voorinstelling annuleren
Als u de automatische voorinstelling wilt annuleren, tikt u tijdens het 
proces op [ ].

Het automatisch voorprogrammeren wordt geannuleerd en alleen de frequenties 
die tot op dat moment zijn ingesteld, worden opgeslagen.

U kunt de opgeslagen stations opnieuw instellen als u de MP3-speler in 
een andere stad gaat gebruiken. Als u de opgeslagen stations wilt wissen 
en nieuwe wilt laten opslaan, hoeft u het proces slechts te herhalen.
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HET MENU FM-RADIO GEBRUIKEN (Vervolg)

Luisteren naar een voorkeuzestation
Tik in de stand met voorinstellingen op [ ] om door 
de voorgeprogrammeerde stations te bladeren.

U kunt naar de opgeslagen radiofrequentie luisteren.

Een voorkeuzestation wissen 
Volg de onderstaande stappen om frequenties te verwijderen terwijl u 
naar de radio luistert.
1. Tik in de stand met voorinstellingen op [ ]

om te zoeken naar een voorgeprogrammeerde 
frequentie die u wilt verwijderen en tik vervolgens 
op [ ].

Het menu <FM Radio> (FM-radio) wordt weergegeven.

2. Tik op [ ] om <Delete from Preset> (Verw. uit 
voorpr.) te selecteren en tik vervolgens op [ ].

De geselecteerde frequentie wordt verwijderd.

3. Als u andere preselectienummers wilt 
verwijderen, volgt u stappen 1-2 hierboven.
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HET MENU FM-RADIO GEBRUIKEN (Vervolg)
Een FM-radio-uitzending opnemen
U kunt op elk gewenst moment een FM-radio-uitzending opnemen 
terwijl u naar de radio luistert.
1. Tik op [ ] om de frequentie te selecteren 

waarin u in de modus FM Radio wilt opnemen en 
tik vervolgens op [ ].

Het menu <FM Radio> (FM-radio) wordt 
weergegeven.

2. Tik op [ ] om <Start Recording> (Opname 
starten) te selecteren en tik vervolgens op [ ].

De naam van het bestand wordt weergegeven en het 
opnemen wordt gestart.

Het opnemen beëindigen
1. Tik tijdens het opnemen op [ ].

U wordt gevraagd of u het bestand dat u zojuist heeft 
opgenomen, wilt beluisteren.

2. Tik op [ ] om <Yes> (Ja) en <No> (Nee) te 
selecteren en tik op [ ].

Als u <Yes> (Ja) kiest, wordt het zojuist opgenomen 
bestand afgespeeld.
Als u <No> (Nee) kiest, wordt het zojuist opgenomen 
bestand niet afgespeeld.
Het opgenomen bestand wordt opgeslagen in 
<File Browser> (Bestandsbrowser)  <Recorded Files> (Opgenomen 
Bestanden).

U kunt maximaal 999 FM-radio-opnamen opslaan.
U kunt ongeveer 23 uur opnamen maken (op basis van 96 Kbps, 1 GB).
De bestandsnaam van de opname wordt automatisch samengesteld, 
bijvoorbeeld “FM_000 mp3”. “FM” geeft aan dat het bestand een FM-
opname is en “000” is het bestandsnummer van de opname.
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HET MENU FM-RADIO GEBRUIKEN (Vervolg)

FM-ontvangst instellen
Met de instelling <FM Sensitivity> (FM Gevoeligheid) kunt u de 
ontvangstgevoeligheid instellen.
1. Tik in de modus FM Radio op [ ].

Het menu <FM Radio> (FM-radio) wordt 
weergegeven.

2. Tik op [ ] om <FM Sensitivity> (FM 
Gevoeligheid) te selecteren en tik vervolgens op 
[ ].

Het menu <FM Sensitivity> (FM Gevoeligheid) wordt 
weergegeven.

3. Tik op [ ] om het zoekniveau te selecteren en 
tik op [ ].

U kunt kiezen uit <High>(Hoog), <Middle>(Midden) en <Low>(Laag).
Als u <High> (Hoog) selecteert, worden meer frequenties ontvangen.
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HET MENU FM-RADIO GEBRUIKEN (Vervolg)
Een FM-regio instellen
U kunt een FM-regio instellen voor reizen naar het buitenland.
1. Tik in de modus FM Radio op [ ].

Het menu <FM Radio> (FM-radio) wordt 
weergegeven.

2. Tik op [ ] om <FM Region> (FM-regio) te 
selecteren en tik vervolgens op [ ].

Het menu <FM Region> (FM-regio) wordt 
weergegeven.

3. Tik op [ ] om het land voor de FM-Radio te 
selecteren en tik op [ ].

U kunt kiezen uit <Korea/US> (Korea/VS), <Japan> (Japan) en <Other 
Countries> (Andere Landen).

Frequentiebereik naar regio
- Korea/US (Korea/VS) : FM-frequenties in 100 kHz-spelers zoeken tussen 

87.5 MHz~108.0 MHz.
- Japan (Japan) : FM-frequenties in 100 kHz-spelers zoeken tussen 76.0 

MHz~108.0 MHz.
- Other Countries (Andere Landen) : FM-frequenties in 50 kHz-spelers 

zoeken tussen 87.50 MHz~108.00 MHz.
De FM-regio kan worden verwijderd of gewijzigd overeenkomstig de 
doelregio voor de speler. 
Opgeslagen radiofrequenties worden gewist wanneer u de instelling <FM 
Region> (FM-regio) op de speler wijzigt.
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de datacast gebruiken
Met <Media Studio> kunt u RSS-bloginformatie en -bestanden naar de speler 
overbrengen.

Wat is RSS?
RSS staat voor Rich Site Summary of Really Simple Syndication. RSS is een 
op XML gebaseerd systeem voor gegevensoverdracht dat wordt gebruikt om 
eenvoudiger informatie weer te geven op websites die vaak worden bijgewerkt, 
zoals nieuwssites en blogs.
Wat zijn datacasts?
U kunt automatisch bijgewerkte informatie ontvangen zonder telkens naar uw 
veelbezochte nieuws-, blog- en UCC-sites te hoeven gaan.
Voordat u begint! - Voordat u begint: Media Studio moet zijn geïnstalleerd op de 

computer. Zie pagina 31.

EEN KANAAL REGISTREREN
U kunt een nieuw kanaal maken door websites of 
webpagina’s met RSS-ondersteuning te registreren.
1. Klik op <Subscribe> (Aanmelden) onder 

aan het gedeelte <Datacasts> van 
<Media Studio>.

2. Voer een adres in bij <URL> en klik op 
< Next>( Volgende).

Als u een webadres kopieert en op 
<Subscribe> (Aanmelden) klikt, wordt het 
gekopieerde adres automatisch weergegeven bij <URL>.
Het venster voor bevestiging van de instellingen wordt weergegeven als het webadres 
ondersteuning biedt voor RSS.

3. Klik op <OK>.
Het gewenste kanaal is geregistreerd.
Het pictogram  wordt weergegeven in Datacasts voor het geregistreerde kanaal.

2

2
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EEN NIEUWE KANAALGROEP MAKEN
U kunt een nieuwe groep maken om uw eigen 
kanalen te beheren.
1. Klik op <New Group> (Nieuwe groep) onder aan het 

gedeelte <Datacasts> van <Media Studio>.
2. Typ een groepsnaam en beschrijving en klik op 

<OK>.

EEN DATACAST OVERBRENGEN VAN <MEDIA STUDIO>
Voordat u begint! - Sluit de speler aan op de computer. 

Media Studio moet zijn geïnstalleerd op de computer. Zie pagina 31.
1. <Media Studio> wordt automatisch gestart 

op het moment dat de speler wordt 
aangesloten op de computer.

Als het programma niet automatisch wordt 
gestart, dubbelklikt u op het <Media Studio>-
pictogram  op het bureaublad.

2. Klik op <Datacasts> boven in <Media 
Studio>.

De lijst met groepskanalen voor Datacasts 
wordt weergegeven.

3. Klik op het gewenste groepskanaal.
4. Klik op het gewenste kanaal.
5. Selecteer de melding dat u wilt overbrengen.
6. Klik op het pictogram .

De melding van het geselecteerde kanaal wordt overgebracht naar de speler in <File 
Browser>(Bestandsbrowser)  <Datacasts>.

Klik op boven in <Media Studio> om naar het vorige scherm te gaan.
Als het bericht een bijlage bevat, kunt u in <Datacasts> in <Media Studio> 
de bijlage downloaden naar de speler. Het kan echter zijn dat de bijlage niet 
gedownload kan worden, afhankelijk van het beleid van de betreffende website.

OPMERKING
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DATACASTS WEERGEVEN
U kunt aan <Datacasts> toegevoegde kanaalberichten weergeven.

Voordat u begint! - Breng het gewenste kanaalbericht over naar de speler met 
<Media Studio> (Media Studio). Zie pagina 69
Tik op [ ] om naar het vorige scherm te gaan.
Houd [ ] iets langer ingedrukt om naar het scherm met het hoofdmenu te gaan.

1. Houd [ ] iets langer ingedrukt om naar het scherm met 
het hoofdmenu te gaan.

2. Tik op [ ] om <Datacasts> te selecteren en tik 
vervolgens op [ ].

De lijst met datacasts wordt weergegeven.

3. Tik op [ ] om een gewenst groepskanaal te selecteren 
en tik vervolgens op [ ].

De titel is hetzelfde als die van het kanaal dat is toegevoegd aan 
Datacasts in <Media Studio>.

4. Tik op [ ] om een gewenst kanaal te selecteren en tik 
op [ ].

De lijst met bestanden wordt weergegeven.

pictogram  : Hoofdtekst van het overgebrachte bericht
pictogram : Afbeeldingsbestand
pictogram  : Muziekbestand
pictogram : Videobestand

5. Tik op [ ] om een gewenst bericht te selecteren en tik 
op [ ].

Het geselecteerde bericht wordt afgespeeld.

Datacast 1
Datacast 2
Datacast 3
Datacast 4
Datacast 5
Datacast 6

Datacasts
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de extra functies gebruiken
Met Prime Pack kunt u genieten van verschillende functies als tekst lezen 
en stemopname.

TEKST LEZEN
Of het nou gaat om een roman, het manuscript van een nieuw verhaal of uw scriptie; 
u kunt het lezen op uw MP3-speler... met uw favoriete muziek op de achtergrond!

Voordat u begint! - De oortelefoon aansluiten, de speler aanzetten en de batterij 
controleren.
Breng tekstbestanden over naar de speler met <Media Studio>. Zie pagina 32.
Tik op [ ] om naar het vorige scherm te gaan.
Houd [ ] iets langer ingedrukt om naar het scherm met het hoofdmenu te gaan.

1. Houd [ ] iets langer ingedrukt om naar het scherm met 
het hoofdmenu te gaan.

2. Tik op [ ] om <Prime Pack> (Hoofdpakket) te 
selecteren en tik vervolgens op [ ].

De <Prime Pack>(Hoofdpakket)-lijst wordt weergegeven.
3. Tik op [ ] om <Text> (Tekst) te selecteren en tik 

vervolgens op [ ].
De lijst met tekstbestanden wordt weergegeven.

4. Tik op [ ] om een gewenst tekstbestand te selecteren 
en tik vervolgens op [ ].

De tekst wordt op het scherm weergegeven.

Naar de vorige/volgende pagina gaan
Tik op [ ].

Houd [ ] iets langer ingedrukt om door de vorige of volgende pagina’s te bladeren.
Uw MP3-speler ondersteunt de bestandsindeling TXT in de tekstmodus.
U kunt ook een tekstbestand zoeken met behulp van de <File Browser> 
(Bestandsbrowser).

OPMERKING
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HET TEKSTMENU GEBRUIKEN
Tik op [ ] om het menu te verlaten.

Naar muziek luisteren terwijl u uw tekst bekijkt.
U kunt naar het laatst afgespeelde nummer luisteren terwijl u uw tekst 
bekijkt.
1. Tik op [ ] terwijl u uw tekst bekijkt.

Het menu <Text>(Tekst) wordt weergegeven.

2. Tik op [ ] om <Music> (Muziek) te selecteren 
en tik vervolgens op [ ].

Het menu <Music>(Muziek) wordt weergegeven.

3. Tik op [ ] om een gewenste modus te 
selecteren en tik op [ ].

<Off> (Uit):  Er wordt geen achtergrondmuziek 
gespeeld terwijl u de tekst bekijkt.

<On> (Aan): U kunt naar het laatst afgespeelde nummer luisteren terwijl u 
de tekst bekijkt.

Naar de eerste pagina gaan
Gebruik deze optie als u de tekst van de eerste pagina wilt bekijken.
1. Tik op [ ] terwijl u uw tekst bekijkt.

Het menu <Text>(Tekst) wordt weergegeven.

2. Tik op [ ] om <Go to 1st page> (Ga naar 1e 
Pagina) te selecteren en tik vervolgens op [ ].

Er wordt een venster weergegeven met daarin de 
bevestiging dat u naar de eerste pagina gaat.

3. Tik op [ ] om <Yes> (Ja) te selecteren en tik 
vervolgens op [ ].

U gaat naar de eerste pagina.
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ET TEKSTMENU GEBRUIKEN (Vervolg)
Tik op [ ] om het menu te verlaten.

Een bladwijzer instellen
Stel een bladwijzer in om een volgende keer terug te gaan naar een 
bepaald punt in de tekst.
1. Tik op [ ] terwijl u uw tekst bekijkt.

Het menu <Text>(Tekst) wordt weergegeven.

2. Tik op [ ] om <Add Bookmark> (Bladwijzer 
toev.) te selecteren en tik vervolgens op [ ].

In het huidige tekstscherm wordt een bladwijzer 
ingesteld en het symbool [ ] wordt linksboven in het 
scherm weergegeven. 

Het venster Overschrijven verschijnt als er al 
eerder een bladwijzer is ingesteld. Als u <Yes>(Ja) 
selecteert, wordt de eerder ingestelde bladwijzer 
verwijderd en wordt er een nieuwe bladwijzer toegevoegd.
U kunt één bladwijzer per tekstbestand instellen met een maximum van 
100 bladwijzers.

Naar de bladwijzer gaan/de bladwijzer verwijderen
1. Tik op [ ] terwijl u uw tekst bekijkt.

Het menu <Text>(Tekst) wordt weergegeven.

2. Tik op [ ] om <Go to Bookmark> (Ga naar 
bladwijzer) of <Delete bookmark> (Bladwijzer 
verw.) te selecteren en tik vervolgens op [ ].

Als u <Go to Bookmark> (Ga naar bladwijzer) 
selecteert, gaat u naar de geselecteerde bladwijzer. 
Met <Delete Bookmark> (Bladwijzer verw.) verwijdert u 
de geselecteerde bladwijzer uit het tekstbestand.
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ET TEKSTMENU GEBRUIKEN (Vervolg)
De kleur van de tekstviewer instellen
Kies in welke kleur u de tekst wilt weergeven.
1. Tik op [ ] terwijl u uw tekst bekijkt.

Het menu <Text>(Tekst) wordt weergegeven.

2. Tik op [ ] om <Text Viewer Color> (Kleur 
tekstviewer) te selecteren en tik vervolgens op [ ].

Het menuvenster <Text Viewer Color>(Kleur 
tekstviewer) wordt weergegeven.

3. Tik op [ ] om een gewenste kleur voor de 
tekstviewer te selecteren en tik vervolgens op [ ].

U kunt kiezen uit <Type 1> tot en met <Type 6>.

De lettergrootte wijzigen
U kunt de lettergrootte van de tekst wijzigen.
1. Tik op [ ] terwijl u uw tekst bekijkt.

Het menu <Text>(Tekst) wordt weergegeven.

2. Tik op [ ] om <Font Size> (Lettergr.) te 
selecteren en tik vervolgens op [ ].

Het menu <Font Size> (Lettergr.) wordt weergegeven.

3. Tik op [ ] om de gewenste lettergrootte te 
selecteren en tik vervolgens op [ ].

U kunt kiezen ui <Small> (Klein), <Medium> (Medium) en <Large>(Groot).

Music
Go to 1st Page
Add Bookmark
Go to Bookmark
Delete bookmark
Text Viewer Color
Font Size
Language

Music
Go to 1st Page
Add Bookmark
Go to Bookmark
Delete bookmark
Text Viewer Color
Font Size
Language



de extra functies gebruiken_ 75

ET TEKSTMENU GEBRUIKEN (Vervolg)
De teksttaal instellen
U kunt een taal instellen voor de tekst die u wilt bekijken.
1. Tik op [ ] terwijl u uw tekst bekijkt.

Het menu <Text>(Tekst) wordt weergegeven.

2. Tik op [ ] om <Language> (Taal) te 
selecteren en tik vervolgens op [ ].

De lijst <Language> (Taal) wordt weergegeven.
<English>, <Korean>, <French>, <German>, 
<Italian>, <Japanese>, <Chinese(S)>, <Chinese(T)>, 
<Spanish>, <Russian>, <Hungarian>, <Dutch>, 
<Polish>, <Portuguese>, <Swedish>, <Thai>, 
<Finnish>, <Danish>, <Norwegian>, <Farsi>, <Afrikaans>, <Basque>, 
<Catalan>, <Czech>, <Estonian>, <Greek>, <Hrvatski>, <Icelandic>, 
<Rumanian>, <Slovak>, <Slovene>, <Turkish>, <Vietnamese>.

3. Tik op [ ] om de gewenste taal te selecteren en tik op [ ].
U kunt de tekst nu in de geselecteerde taal bekijken.

De ondersteunde talen kunnen worden gewijzigd of uitgebreid.
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STEMOPNAME
Hiermee kunt u een stemopname maken.

Een stemopname maken
1. Houd [ ] iets langer ingedrukt om naar het 

scherm met het hoofdmenu te gaan.
2. Tik op [ ] om <Prime Pack> (Hoofdpakket) te 

selecteren en tik vervolgens op [ ].
Het menu <Prime Pack> (Hoofdpakket) wordt 
weergegeven.

3. Tik op [ ] om <Voice REC> (Stemopname) te 
selecteren en tik vervolgens op [ ].

De naam van het bestand wordt weergegeven en het 
opnamevenster verschijnt.

4. Tik op [ ].
Het opnemen wordt gestart.

U kunt ongeveer 23 uur opnamen maken (op basis van 96 Kbps, 1 GB).
U kunt maximaal 999 bestanden voor stemopnamen opslaan.OPMERKING
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STEMOPNAME (Vervolg)

De stemopname beëindigen
1. Tik tijdens het opnemen op [ ].

U wordt gevraagd of u het bestand dat u zojuist heeft 
opgenomen, wilt beluisteren.

2. Tik op [ ] om <Yes> (Ja) en <No> (Nee) te 
selecteren en tik op [ ].

Als u <Yes> (Ja) kiest, wordt het zojuist opgenomen 
bestand afgespeeld.
Als u <No> (Nee) kiest, wordt het zojuist opgenomen 
bestand niet afgespeeld.
Het opgenomen bestand wordt opgeslagen in 
<File Browser> (Bestandsbrowser)  <Recorded Files> (Opgenomen 
Bestanden).

Plaats de microfoon niet te ver weg of te dichtbij uw mond tijdens de 
opname. Dit kan ten koste gaan van de opnamekwaliteit. 
Stemopname werkt niet goed als de batterij bijna leeg is.
De bestandsnaam van de opname wordt automatisch samengesteld, 
bijvoorbeeld “VCE_000 mp3”. “VCE” geeft aan dat het bestand een 
stemopname is en “000” is het bestandsnummer van de opname.

OPMERKING
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Bluetooth gebruiken
Tik op [ ] om naar het vorige scherm te gaan.
Houd [ ] iets langer ingedrukt om naar het scherm met het hoofdmenu te gaan. 

WAT IS BLUETOOTH?
Bluetooth is een industriestandaard voor draadloze PAN’s (personal area networks). 
Bluetooth biedt verbinding en uitwisseling tussen apparaten als mobiele telefoons, 
laptops, pc’s, printers, digitale camera’s en videospelcomputers via een beveiligde, 
wereldwijd ongelicentieerde korte golf radiofrequenties.

Afhankelijk van de gebruiksomstandigheden kunnen Bluetooth-apparaten ruis of 
storingen veroorzaken.

Fysieke signaalstoringen, zoals wanneer u de speler in de hand houdt en een 
stereokoptelefoon draagt.
Wanneer een deel van het lichaam in contact is met het ontvangstsysteem van de speler of 
de stereokoptelefoon.
Spanningsvariatie als gevolg van elektrische storing door muren, hoeken of 
scheidingswanden.
Elektrische interferentie door apparatuur die dezelfde frequentie gebruikt, bijvoorbeeld 
medische apparatuur, magnetrons en draadloze LAN’s.

Houd de afstand tussen het Bluetooth-apparaat en de speler zo klein mogelijk.
Hoe groter de afstand tussen de speler en de stereokoptelefoon, des te slechter de 
kwaliteit. Als de afstand de limiet overschrijdt, wordt de verbinding verbroken.
We raden af om de tekst- en afbeeldingsopties te gebruiken terwijl u naar muziek 
luistert via de stereokoptelefoon. Dit verslechtert zowel de prestaties van de speler 
als de Bluetooth-communicatie.
Bestanden met minder dan 32 kHz kunnen niet worden afgespeeld, afhankelijk van 
het model stereokoptelefoon.
In gebieden met een slechte ontvangst, bijvoorbeeld in een lift of ondergronds, 
werkt de Bluetooth-verbinding mogelijk niet goed.
De maximumafstand voor draadloze verbinding tussen de speler en een Bluetooth-
apparaat is 10 meter. Als de afstand groter wordt, wordt de verbinding automatisch 
verbroken. Zelfs binnen dit bereik kan de geluidskwaliteit verslechteren door 
obstakels zoals muren of deuren.

OPMERKING
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EEN BLUETOOTH-STEREOKOPTELEFOON GEBRUIKEN
U kunt een Bluetooth-stereokoptelefoon gebruiken om draadloos van muziek te 
genieten met stereogeluid van een hoge kwaliteit.

Voordat u begint! - Zorg ervoor dat het Bluetooth-apparaat dat u wilt 
aansluiten klaar is om te worden gekoppeld. (raadpleeg de 
gebruikshandleiding van het apparaat)

De Bluetooth-stereokoptelefoon registreren
(U hoeft dit product slechts één keer te registreren)
1. Houd [ ] iets langer ingedrukt om naar het 

scherm met het hoofdmenu te gaan.
2. Tik op [ ] om <Bluetooth> te selecteren en tik 

vervolgens op [ ].
De <Bluetooth Mode> (Bluetooth Mode) is ingesteld op 
<On>(Aan).
Het pictogram  licht op.

3. Maak de stereo-koptelefoon gereed voor koppeling.
Raadpleeg de producthandleiding om de koptelefoon 
gereed te maken voor de koppeling.

4. Tik op [ ] om <Stereo Headset> (Stereo Koptelefoon) te 
selecteren en tik vervolgens op [ ].
  <Search New Device> (Nieuw apparaat zoeken) wordt op het scherm 
weergegeven als er eerder een apparaat aan de speler is gekoppeld. 
Selecteer <Search New Device> (Nieuw apparaat zoeken), om te zoeken 
naar een nieuw apparaat om te koppelen.
De te registreren koptelefoon wordt in de lijst opgenomen.

5. Tik op [ ] om de naam van de koptelefoon te selecteren en tik 
op [ ].

Het venster voor het invoeren van het wachtwoord wordt weergegeven als 
het wachtwoord voor de koptelefoon anders is dan 0000. Raadpleeg de 
handleiding van de koptelefoon voor het wachtwoord.
De registratie van de koptelefoon is voltooid.
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EEN BLUETOOTH-STEREOKOPTELEFOON 
GEBRUIKEN (Vervolg)

De Bluetooth-stereokoptelefoon registreren (vervolg)

U kunt de Bluetooth-functie alleen gebruiken voor het afspelen van muziek- 
en videobestanden. Er is geen ondersteuning voor het luisteren naar 
FM-radio.

Beschrijving van het Bluetooth-pictogram
 : Bluetooth-modus aan  : Verbonden met een stereo-koptelefoon

U kunt de Bluetooth-functie uitschakelen via <Bluetooth> (Bluetooth) 
<Bluetooth Mode> (Bluetooth Mode)  <Off>(Uit).

Koptelefoons die geschikt zijn voor Bluetooth
Fabrikant Model Fabrikant Model

i.TECH Blueband SAMSUNG SBH100
Plantronics PULSAR 590A Jabra BT620s
MOTOROLA HT820

Gebruik alleen stereo-koptelefoons die zijn gecertifi ceerd voor Bluetooth. 
Handsfree mono-koptelefoons worden niet ondersteund.

Schakel de <Bluetooth Mode> (Bluetooth Mode) naar <Off> (Uit) als deze 
niet in gebruik is. Als u de <Bluetooth Mode> (Bluetooth Mode) in de stand 
<On> (Aan) laat staan, loopt de batterij sneller leeg.

U kunt maximaal 20 apparaten toevoegen voor de Bluetooth-verbinding.

OPMERKING
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EEN BLUETOOTH-STEREOKOPTELEFOON 
GEBRUIKEN (Vervolg)

Verbinding maken met de geregistreerde Bluetooth-
stereokoptelefoon

1. Tik op [ ] in het scherm Bluetooth om <Stereo
Headset> (Stereo Koptelefoon) te selecteren en 
tik op [ ].

2. Tik op [ ] om een stereokoptelefoon te 
selecteren die u wilt verbinden en tik op [ ].

Wanneer de verbinding tot stand is gebracht, ziet u het 
pictogram  op het scherm. 
U kunt verbinding maken met maximaal twee 
koptelefoons.

3. Speel de muziek af.
U kunt met een stereo-koptelefoon naar muziek luisteren.

Als u de gewenste koptelefoon niet kunt vinden, moet u deze eerst 
registreren.

De Bluetooth-verbinding wordt verbroken als u de speler of de koptelefoon 
uitschakelt en na een seconde weer inschakelt. Herhaal de bovenstaande 
instructies als u met de stereo-koptelefoon naar muziek wilt luisteren.

Als er verbinding is met twee koptelefoons, kan alleen de koptelefoon 
waarmee het eerst verbinding is gemaakt, worden ingeschakeld voor 
functionele bediening zoals afspelen/stoppen en volumeregeling. 
Raadpleeg de handleiding van de koptelefoon voor meer informatie.

OPMERKING

Stereo Headset
Bluetooth Mode
Bluetooth Settings

Bluetooth
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HET BLUETOOTH-MENU GEBRUIKEN
De verbinding met het Bluetooth-apparaat verbreken
1. Tik op [ ] in het Bluetooth-scherm.

2. Tik op [ ] om <Disconnect> (Afsluiten) te 
selecteren en tik vervolgens op [ ].

Het bevestigingsvenster voor het verbreken van de 
verbinding wordt weergegeven.

3. Tik op [ ] om <Yes> (Ja) te selecteren en tik 
vervolgens op [ ].

Het aangesloten apparaat wordt losgekoppeld.

Het verbonden Bluetooth-apparaat controleren
1. Tik op [ ] in het Bluetooth-scherm.

2. Tik op [ ] om <Connected Device>
(Verbonden apparaat) te selecteren en tik 
vervolgens op [ ].

Er wordt informatie over het aangesloten apparaat 
weergegeven.

Disconnect
Connected  Device

Disconnect
Connected Device
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BLUETOOTH-INSTELLINGEN
Voordat u begint! - Stel de <Bluetooth Mode> in op <On> (Aan).

1. Houd [ ] iets langer ingedrukt om naar het scherm met 
het hoofdmenu te gaan.

2. Tik op [ ] om <Bluetooth> te selecteren en tik 
vervolgens op [ ].

3. Tik op [ ] om <Bluetooth Settings> (Bluetooth 
Instellingen) te selecteren en tik vervolgens op [ ].

Het menu <Bluetooth Settings>(Bluetooth Instellingen) wordt 
weergegeven.

4. Gebruik de toetsen [ ] en [ ] om de functies in te stellen.

Opties voor Bluetooth-instellingen
Search Timeout (Zoek Timeout) : U kunt selecteren hoe lang er naar een nieuw 
apparaat wordt gezocht. Na het instellen van een tijd, wordt er naar een nieuw apparaat 
gezocht gedurende de tijd die u hebt ingesteld. U kunt kiezen uit <10sec>, <20sec>, 
<30sec>, <45sec> en <60sec>.
Delete Device (Apparaat verwijderen) : U kunt de registratie van een apparaat uit de 
speler verwijderen. Zie pagina 84. 
Selecteer <Delete All> (Alles verwijderen) om alle geregistreerde apparaten te 
verwijderen.
My Device Info. (Mijn Apparaat Informatie) : U kunt de naam en het adres van uw 
speler nagaan.

Stereo Headset
Bluetooth Mode
Bluetooth Settings

Bluetooth
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BLUETOOTH-INSTELLINGEN (Vervolg)

Een Bluetooth-apparaat verwijderen
1. Tik op [ ] om <Delete Device> (Apparaat 

Verwijderen) te selecteren en tik vervolgens op [ ].
De lijst van geregistreerde apparaten wordt weergegeven.

2. Tik op [ ] om het apparaat te selecteren dat u wilt 
verwijderen en tik op [ ].

Selecteer <Delete All> (Alles verwijderen) als u alle 
geregistreerde apparaten wilt verwijderen.

3. Tik op [ ] om <Yes> (Ja) te selecteren en tik 
vervolgens op [ ].

Het geselecteerde apparaat wordt verwijderd.

Een Bluetooth-apparaat hernoemen
1. Tik op [ ] om <My Device Info> (Mijn Apparaat 

Informatie) te selecteren en tik vervolgens op [ ].
2. Tik op [ ].

Het scherm Mijn Apparaat Informatie wordt weergegeven.
3. Tik op [ ] om <Edit Device Name> (Wijzig 

Apparaatnaam) te selecteren en tik vervolgens op [ ].
Het venster Edit Device Name (Wijzig Apparaatnaam) 
wordt weergegeven.

4. Wijzig de naam van het apparaat met de toetsen 
[ ] en [ ].

[ ] : De invoermodus schakelt over van cijfers naar Engels met hoofdletters en 
Engels met kleine letters.

[ ] : U kunt de tekens één voor één wissen.
[ ] : Hiermee bevestigt u de wijziging.
Als u bijvoorbeeld ‘YPS5’ wilt invoeren:
-Ga naar het overeenkomstige toetspictogram en tik erop.

(één keer)  (drie keer)  (één keer)  (drie keer) 
(twee keer)  (één keer)

Search Timeout
Delete Device
My Device Info.

Bluetooth Settings

Edit Device Name
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problemen oplossen
Als u problemen ondervindt met uw nieuwe MP3-speler, vindt u mogelijk een 
oplossing in deze lijst. Als het probleem zich blijft voordoen, kunt u contact 
opnemen met het dichtstbijzijnde Samsung Customer Service Center.

PROBLEM OPLOSSING

Kan de speler niet 
inschakelen.

• De speler kan niet worden ingeschakeld als de 
batterij helemaal leeg is. Laad de batterij op en 
schakel de speler nogmaals in.

• Druk met een scherp voorwerp de 
resetopening in.

De toetsen werken niet.

• Controleer of de schakelaar in de 
richting van de pijl is geduwd.

• Controleer of u op de juiste toets hebt gedrukt, 
en druk nogmaals op de toets.

• Druk met een scherp voorwerp de 
resetopening in.

Het scherm wordt niet 
ingeschakeld.

• Het scherm is in vol zonlicht mogelijk niet goed 
zichtbaar.

• Als <Display Off> (Display Uit) is geselecteerd 
in <Settings> (Instellingen) <Display>
(Weergave), wordt het scherm uitgeschakeld.
Tik op een willekeurige toets om te zien of het 
wordt ingeschakeld.
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PROBLEM OPLOSSING

De speler wordt 
uitgeschakeld.

• Controleer de batterijstatus.
• De speler wordt automatisch uitgeschakeld 

wanneer de batterij helemaal leeg is. Laad de 
batterij op.

• Als u <Auto Power Off>(Autom. Uitschakelen) 
selecteert via <Settings>(Instellingen)
<System>(Systeem), zal de speler in de 
pauzestand worden uitgeschakeld. Schakel de 
speler in.

De levensduur van 
de batterij verschilt 
met de levensduur die 
is aangegeven in de 
gebruiksaanwijzing.

• Hoelang de batterij meegaat kan 
variëren, afhankelijk van de geluids- en 
scherminstellingen.

• Wanneer de speler langdurig wordt blootgesteld 
aan lage of hoge temperaturen, kan dit ten 
koste gaan van de levensduur van de batterij.

Storingen in de werking 
van Media Studio

• Controleer of uw computer voldoet aan de 
minimum systeemvereisten.

Kan geen verbinding 
met de computer 
maken.

• Controleer of de USB-kabel juist is aangesloten 
en probeer het nogmaals.

• Klik op <Start> op het bureaublad van de 
computer om Windows Update uit te voeren. 
Selecteer Essentiële updates en Service packs 
en installeer alle updates. Start de computer 
opnieuw op en sluit de speler opnieuw aan.

De overdrachtssnelheid 
van bestanden is te 
laag.

• De overdrachtssnelheid is lager als u meerdere 
programma’s, waaronder <Media Studio>, 
op uw computer uitvoert. Sluit overbodige 
programma’s af en probeer het nog eens.
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PROBLEM OPLOSSING

De speler speelt niet af

• Controleer of het beschikbare bestand is opgeslagen 
in het geheugen.

• Controleer of het muziekbestand is beschadigd.
• Controleer of de batterij voldoende is opgeladen.

Het uploaden van 
bestanden werkt niet.

• Controleer of de USB-kabel goed is aangesloten. 
Sluit deze zonodig opnieuw aan.

• Controleer of het geheugen vol is.
• Druk met een scherp voorwerp de resetopening in.

Er ontbreken bestanden 
of gegevens.

• Controleer of de USB-kabel is losgeraakt tijdens de 
bestandsoverdracht. Dit kan overigens niet alleen 
leiden tot ernstige beschadiging van de bestanden/
gegevens, maar ook van het product. 
Let goed op, want Samsung is niet aansprakelijk voor 
gegevensverlies.

Abnormale afspeeltijd 
tijdens het afspelen.

• Controleer of het bestand een VBR-indeling (Variable 
Bit Rate) heeft.

Het product wordt 
warm.

• Er komt tijdens het opladen wat warmte vrij. Dit heeft 
geen invloed op de levensduur of functies van het 
product.

Er wordt een melding 
weergegeven tijdens het 
bekijken van een video.

• Probeer de videoclip nogmaals te downloaden met 
Media Studio.

Bluetooth-verbindingen
konden niet tot stand 
worden gebracht.

• Controleer of de stereo-koptelefoon geschikt is voor 
Bluetooth. Handsfree mono-koptelefoons worden niet 
ondersteund.

• De Bluetooth-verbinding kan worden uitgeschakeld 
als u de speler of stereokoptelefoon uit- en inschakelt. 
Probeer in dit geval opnieuw verbinding te maken.
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bijlage
OVERZICHT VAN MENUOPTIES
Hier vindt u een overzicht van de structuur van de menu’s en functies op uw 
nieuwe MP3-speler.

Het selectievenster Menu

Music Videos Pictures FM
Radio Datacasts Prime

Pack
File

Browser Bluetooth Settings

Text Stereo
Headset Menu Style

Voice REC Bluetooth
Mode Sound

Bluetooth
Settings Display

Language

Date&Time

System
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PRODUCTSPECIFICATIES

Model YP-T10
Classifi catie DC 5.0V / 500mA
Vermogen 

ingebouwde batterij 550 mAh / DC 3.7V

Bestand 
Compatibiliteit

GELUID :  MPEG1/2/2.5 Layer3 (8kbps-320kbps, 
22kHz-48kHz), WMA (8kbps-320kbps, 
8kHz-48kHz)

VIDEO :  SVI (video: MPEG4; audio: MP3 (44.1kHz, 
128Kbps); 
WMV (video: WMV9 Simple Profi le; audio: 
WMA (max. 860kbps); 
Resolutie: 320x240; framerate: 30fps)

BEELD :  JPEG(ISO/IEC 10918-1/
Annex F-Sequential DCT-weergave)

Uitgangsvermogen 
oortelefoon 20mW (France 5mW/CH) (16Ω)

Frequentiebereik 20Hz~20KHz
Signaal/

ruisverhouding 90 dB bij 20 KHz LPF (gebaseerd op 1kHz 0 dB)

Afspeelduur
Maximaal 30 uur muziek afspelen (op basis van 
MP3 128kbps, volume 15, normale geluidsmodus), 
maximaal 4 uur video afspelen

Temperatuurbereik 
voor gebruik -5~35°C (23~95°F)

Houder Plastic, Aluminium
Gewicht 43g

Afmetingen (BxHxD) 41.5 X 96 X 7.9 mm
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FM Radio
FM-frequentie 87.5~108.0MHz Totale harmonische 

vervorming FM 1%

Signaal-
ruisverhouding FM 50 dB Gevoeligheid FM 30dB

Draadloos systeem
Emissietype F1D
RF-stroomvoorziening 1.8mW
Zendfrequentie 2402MHz ~ 2480MHz
Ontvangstfrequentie 2402MHz ~ 2480MHz
Aantal kanalen 79 kan.
Temperatuur -10 °C~ +50°C(14 ~ 122°F)
Modulatiesysteem GFSK
Communicatiemodus Semi-duplex communicatie
Vochtigheid 95%
Spec. ondersteunde versie 2.0
Module BTEM48B2SA

De inhoud van deze gebruiksaanwijzing kan ter verbetering zonder 
voorafgaande kennisgeving worden gewijzigd.
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LICENTIE
Op dit apparaat en de gebruiksaanwijzing rusten intellectuele eigendomsrechten 
en auteursrechten van derden. Het gebruiksrecht van de gelicentieerde inhoud 
is beperkt tot niet-commercieel gebruik door eindgebruikers. Commercieel 
gebruik hiervan is niet toegestaan. Het gebruiksrecht beperkt zich tot dit 
apparaat en strekt zich niet uit tot andere niet-gelicentieerde onderdelen 
of processen die voldoen aan ISO/IEC 11172-3 of ISO/IEC 13818-3 en die 
in combinatie met dit product gebruikt of verkocht zijn. De licentie beperkt 
zich tot het gebruik van dit product voor het encoderen en/of decoderen van 
geluidsbestanden die voldoen aan ISO/IEC 11172-3 of ISO/IEC 13818-3. 
Deze licentie houdt geen overdracht van rechten in voor producteigenschappen 
of -functies die niet voldoen aan ISO/IEC 11172-3 of ISO/IEC 13818-3.

GEBRUIKSRECHT
Dit merkteken op het product of het bijbehorende 
informatiemateriaal duidt erop dat het niet met ander 
huishoudelijk afval verwijderd moet worden aan het einde 
van zijn gebruiksduur. Om mogelijke schade aan het 
milieu of de menselijke gezondheid door ongecontroleerde 
afvalverwijdering te voorkomen, moet u dit product van 
andere soorten afval scheiden en op een verantwoorde 
manier recyclen, zodat het duurzame hergebruik van 
materiaalbronnen wordt bevorderd.
Huishoudelijke gebruikers moeten contact opnemen met 
de winkel waar ze dit product hebben gekocht of met de 
gemeente waar ze wonen om te vernemen waar en hoe ze 
dit product milieuvriendelijk kunnen laten recyclen.
Zakelijke gebruikers moeten contact opnemen met 
hun leverancier en de algemene voorwaarden van de 
koopovereenkomsten nalezen. Dit product moet niet 
worden gemengd met ander bedrijfsafval voor verwijdering.



Declaration of Conformity
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